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About This Guide 
This guide presents the information contained in the Avaya IP Softphone R4 Version 1 online help.   
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About Avaya IP Softphone 

Introduction 

Avaya IP Softphone is a collection of computer telephony integration (CTI) applications that 
enables you to control telephone calls (both incoming and outgoing) directly from your PC. 
Avaya IP Softphone enables you to log into your company's server remotely and make and 
receive telephone calls from the telephone extension. 

Avaya IP Softphone increases your telecommunications capabilities by providing the following 
applications: 

• Avaya IP Softphone 

Avaya IP Softphone is an application that enables you to control your telephone calls 
(both incoming and outgoing) directly from your PC. 

• Avaya iClarity IP Audio 

Avaya iClarity IP Audio is an application that performs the following functions: 

o Enables you to log into the server. You must be logged into the server before 
you can use Avaya IP Softphone to control your telephone calls. 

o Handles the voice communications when you use Avaya IP Softphone in the 
Road Warrior configuration (voice over IP). When you make or receive a call 
with Avaya IP Softphone, Avaya iClarity IP Audio enables you to speak to and 
hear the other party via a headset connected to your PC or the PC’s 
microphone and speakers. 

Avaya IP Softphone Configurations 

Avaya IP Softphone supports the following three configurations: 

• Road Warrior Configuration (Voice over IP) 

The Road Warrior configuration enables travelers to use the full feature set of your 
company's telephone system from temporary remote locations anywhere in the world 
(such as a hotel room). The Road Warrior configuration consists of two software 
applications running on a PC that is connected to the server over an IP network. The 
single network connection between the PC and server carries two channels, one for 
the signaling path and one for the voice path. Avaya IP Softphone software handles 
the call signaling, and Avaya iClarity IP Audio (an H.323 V2-compliant audio 
application) handles the voice communications. The user places and receives calls via 
the Avaya IP Softphone interface on the PC and uses a headset connected to the PC 
(or the PC's microphone and speakers) to speak and listen. 

Avaya iClarity IP Audio runs in the background and starts automatically when you start 
Avaya IP Softphone. 

• Telecommuter Configuration 

The Telecommuter configuration of Avaya IP Softphone enables telecommuters to 
use the full feature set of your company's telephone system from home. The 
Telecommuter configuration consists of a PC and a telephone with separate 
connections to the server. The PC is connected to the server over an IP network to 
provide the signaling path. The PC runs the Avaya IP Softphone software, providing 
you with an interface to control calls. A standard telephone is connected to the server 
over the public-switched telephone network (PSTN) to provide a high-quality voice 
path. You place and receive calls via the Avaya IP Softphone interface on the PC and 
use the telephone handset to speak and listen. 
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If you receive an incoming call on your separate telephone line while you are active on 
a call with Avaya IP Softphone, that caller will hear either ringing (if you have call 
waiting on that line) or a busy signal. If you have call waiting, you can answer the 
incoming calls as you would answer any other call waiting call. 

For the Telecommuter configuration, you must have a separate telephone line 
available at your remote location. 

• Avaya IP Telephone Configuration 

The Avaya IP Telephone configuration enables users to log into and control their 
Avaya IP telephone from Avaya IP Softphone. As with the Telecommuter 
configuration, you use the telephone to speak and listen. Unlike the Telecommuter 
configuration, you can make and handle calls from both the Avaya IP Softphone 
interface and your IP telephone. 

For the Avaya IP Telephone configuration, you must have an Avaya 4606, 4612, 
4620, 4624, or 4630 IP telephone that has the software that supports the remote login 
(CTI) feature. Contact your System Administrator to get the latest software for your IP 
telephone. 

Avaya IP Softphone Features 

From the Avaya IP Softphone window, you can: 

• Manage multiple call appearances. 

• Make calls. 

• Answer calls. 

• View the calling/called party information for each call (referred to as caller ID for the 
calling party information), if available. 

• Place calls on hold. 

• Answer a held call. 

• Hang up calls. 

• Transfer calls. 

• Set up and manage conference calls. 

• Program speed dial buttons. 

• Access all the features programmed for your telephone. 

• Place calls from the Phone Directory window, Call History window, and Public 
Directory. 
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Avaya IP Softphone Main Window 

The Avaya IP Softphone application has been designed with your convenience in mind. 
Avaya IP Softphone supports two "views" of your telephone: 

• Call Bar window (the main window) 

• Picture of Phone window 

The Call Bar window, which is the main window, is a graphical user interface (GUI) that 
enables you to handle calls and access telephone system features via menus and buttons. 
Each call appearing on your extension is represented as a call appearance, which displays 
information about the call. 

Sample Avaya IP Softphone window: 

 

 

The main window contains the following components: 

• Title Bar: The information displayed in the Title Bar depends on whether you are 
logged into the server and whether there are any call appearances present. If you are 
logged in and there are no call appearances, the Title Bar displays the extension you 
are logged in as. If there are call appearances, the Title Bar displays the name and/or 
telephone number associated with the active call. If you are not logged in, the Title Bar 
displays "Not Logged In." 

In the above example, the user is logged into the server and is active on a call. 

• Menu Bar: Contains a row of menu options, any of which you may select to display a 
menu. 

• Toolbars: Contain a row of buttons used to activate various functions of the Avaya IP 
Softphone application. The Avaya IP Softphone main window can contain as many as 
six toolbars. 

• Call Appearance: Provides information about a single call, such as name, call 
duration, status icon, and a control button (for example, Answer, Hangup and 
Unhold). 

• Phone Display: Receives information from the telephone system. This is the same 
information that would appear on the display of your telephone. 

• Status Bar: Displays Avaya IP Softphone application status and tooltips. 

All window sizes and open dialog boxes are saved on exiting the window. When you open the 
main window the next time, it will look exactly the same as it did when you closed it, including 
the same location, size, and open dialog boxes. 
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Toolbars 

The following toolbars are associated with the Avaya IP Softphone main window: 

• Phone Buttons toolbar 

• Dial Number toolbar 

• Audio Control toolbar 

• Message Waiting toolbar 

• Login Options 

• Audio Settings 

These toolbars contain buttons that you can use for quick access to specific commands and 
tools. The toolbars are shown below. For more information on the toolbars, see “Displaying 
Toolbars and the Dial Pad.” 

Phone Buttons Toolbar 

 

Dial Number Toolbar 

 

Audio Control Toolbar 

 

Message Waiting Toolbar 

 

Login Options Toolbar 

 

Audio Settings Toolbar 
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Picture of Phone Window 

The Picture of Phone window provides a picture of your telephone. Using the Picture of 
Phone window, you can handle calls and access station features by performing the same 
procedures you would perform from your telephone. You can also change the labels 
displayed for softkeys and buttons displayed in the Picture of Phone window by clicking on 
the label you want to change or using the Phone Features window. 

Sample Picture of Phone window for a 6408D: 
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The Picture of Phone window is available for the following telephones: 

• 4612 

• 4624 

• 6408D 

• 6408D+ 

• 6416D+ 

• 6416D+ with an expansion module 

• 6424D+ 

• 6424D+ with an expansion module 

• 8405D 

• 8405D+ 

• 8410D 

• 8411D (For this phone, the System Administrator must disable the data port, which is 
true for all softphones.) 

• 8434D 

Expansion modules are supported when configured for the 6416D+ and 6424D+ telephones. 

Supported Phones 

Here is a list of phones that Avaya supports for use with Avaya IP Softphone. You may use 
other phones. However, phones other than those on the following list may not function 
correctly and are not supported by Avaya. 

• 2420 

• 2420 with an expansion module 

• 4602 

• 4606 

• 4612 

• 4620 

• 4620 with an expansion module 

• 4624 

• 4630 

• 6402D 

• 6408D 

• 6408D+ 

• 6416D+ 

• 6416D+ with an expansion module 

• 6424D+ 

• 6424D+ with an expansion module 

• 8405D 

• 8405D+ 



 8 

• 8410D 

• 8411D (For this phone, the System Administrator must disable the data port, which is 
true for all softphones.) 

• 8434D 

• 8434D with an expansion module 

Expansion modules are supported when configured for the 2420, 4620, 6416D+, 6424D+, and 
8434D telephones. 

Dialing Emergency Numbers 

Avaya IP Softphone can dial emergency calls (for example, 911 calls in the U.S.). It will reach 
solely the local emergency service in the Public Safety Answering Point area where the 
server is located. 

Please be advised that Avaya IP Softphone will not dial to and connect with local emergency 
service when dialing from remote locations. You should not use Avaya IP Softphone to dial 
emergency numbers for emergency services when dialing from remote locations. 

Avaya Inc. will not be responsible or liable for any damages or injuries resulting from 
misplaced emergency calls made from Avaya IP Softphone. Your use of this product indicates 
that you have read this advisory and agree to use an alternative telephone to dial all 
emergency calls from remote locations. 
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Dialing Emergency Numbers 

Introduction 

Avaya IP Softphone can dial emergency calls (for example, 911 calls in the U.S.). It will reach 
solely the local emergency service in the Public Safety Answering Point area where the 
telephone system is located. 

Please be advised that Avaya IP Softphone will not dial to and connect with local emergency 
service when dialing from remote locations. You should not use Avaya IP Softphone to dial 
emergency numbers for emergency services when dialing from remote locations. 

Avaya Inc. will not be responsible or liable for any damages or injuries resulting from 
misplaced emergency calls made from Avaya IP Softphone. Your use of this product indicates 
that you have read this advisory and agree to use an alternative telephone to dial all 
emergency calls from remote locations. 
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Bandwidth Setting 
When using Avaya iClarity IP Audio, you must specify how your PC connects to the server. 
(This is the bandwidth setting.) Avaya iClarity IP Audio uses the bandwidth setting to 
determine which codec to use with the server. Avaya iClarity IP Audio has the following 
bandwidth settings: 

• Cable connection 

For a cable connection, the following codecs may be used: 

o G.729a (This codec is used for mid-speed connections.) 

o G.723 (This codec is used for low-speed connections.) 

• xDSL connection 

For an xDSL connection, the following codecs may be used: 

o G.729a (This codec is used for mid-speed connections.) 

o G.723 (This codec is used for low-speed connections.) 

• ISDN connection 

For an ISDN connection, the following codecs may be used: 

o G.729a (This codec is used for mid-speed connections.) 

o G.723 (This codec is used for low-speed connections.) 

• Local Area Network (LAN) connection 

For a LAN connection, the following codecs may be used: 

o G.711 u-law (CCITT u-law) (This codec is used for high-speed connections.) 

o G.711 A-law (CCITT A-law) (This codec is used for high-speed connections.) 

o G.729a (This codec is used for mid-speed connections.) 

o G.723 (This codec is used for low-speed connections.) 

• 28800 bps or better mode connection 

For a 28800 bps or better mode connection, the G.723 codec may be used. (This 
codec is used for low-speed connections.) 

When you connect to the server, Avaya iClarity IP Audio uses the bandwidth setting you 
specified to select the appropriate codec that is compatible with the server configuration.  
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Learning the Main Window 

Introduction 

The Avaya IP Softphone main window provides full-function, multi-line telephony support on 
your PC. 

Learning the Main Window defines all of the options available in the Avaya IP Softphone 
menus. Not all of the items will be available to you all of the time. If an item is not available in 
the current window, it is grayed out. 

File Menu 

The following table lists the File menu commands and a description of each command. 

Menu 
Command 

Description 

Log in Displays the Login dialog box. If you are already logged in, this item is 
disabled. 

Log off Logs you off the server and then displays the Login dialog box. 

Import 
Settings 

Enables you to import previously saved files containing phone settings, 
program options, and configurations. 

Export 
Settings 

Enables you to export the phone settings, program options, and 
configurations from Avaya IP Softphone to a file for later use. 

The options imported and exported include all the options displayed on the Options dialog 
box except the Voice Message Directory Entry option. The configuration information 
includes all administered call events along with the DDE or Web Page triggers. It also 
includes Public Directory administration and the server name or IP address. Select 
Options from the Tools menu to review the Options choices. 

Close Closes the Call Bar window. 

Exit Quits the application and logs off the server. 

Edit Menu 

The following table lists the Edit menu commands and a description of each command. 

Menu 
Command 

Description 

Cut (Ctrl+X) Cuts any text selection, such as names or numbers, in the number 
text box. 

Copy (Ctrl+C) Copies any text selection, such as names or numbers, in the number 
text box. 

Paste (Ctrl+V) Pastes any text selection, such as names or numbers, in the number 
text box. 
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Call Menu 

The following table lists the Call menu commands and a description of each command. Note 
that the Call menu is available only when there is a call appearing on your telephone. 

Menu 
Command 

Submenu 
Command 

Description 

Drop  Disconnects the active call. After the call is 
dropped, the telephone system provides dial tone. 

Hold  Places the active call on hold. If the call is on hold, 
this option will answer the held call. 

Transfer Unsupervised 
Transfer 

Enables you to transfer the active call without 
speaking to the party that will receive the call. 

 Supervised 
Transfer 

Enables you to transfer the active call. This option 
allows you to speak to the destination party before 
that person receives the call. 

Conference  Enables you to add the call to a conference. 

 



 13 

View Menu 

The following table lists the View menu commands and a description of each command. For 
more information on toolbars, see “Displaying Toolbars and the Dial Pad.” 

Menu 
Command 

Submenu 
Command 

Description 

Phone 
Display 

 Displays the Phone Display panel, which displays information that 
would appear on the display of your telephone. 

Dial Pad  Displays the Dial Pad, which may be used to enter numbers for cut-
through dialing. 

Toolbars Show 
Labels 

Displays the text labels for the buttons on the Phone Button toolbar. 

 Phone 
Buttons 

Displays the Phone Button toolbar, which contains the Drop, Hold, 
Transfer, and Conference buttons. 

 Dial 
Number 

Displays the Dial Number toolbar, which enables you to enter 
numbers you want to dial and access various lists. This toolbar 
contains the Dial Number button. Enter telephone numbers you 
want to dial. 

 Audio 
Control 

Displays the Audio Control toolbar, which provides buttons that 
enable you to adjust the volume and view the status of the Avaya 
iClarity IP Audio application. 

 Message 
Waiting 

Displays the Messaging Waiting toolbar, which consists of one 
button that enables you to access your voice messaging system. 

 Login 
Options 

Displays the Login Options toolbar, which enables you to log 
into/log out of the server and modify the login settings. 

 Audio 
Settings 

Displays the Audio Settings toolbar, which enables you to modify 
the audio options for Avaya iClarity IP Audio, adjust the volume 
setting of the speakers, microphone, and ringer, and specify 
whether ringing is played through the internal PC speaker. 

Status Bar  Shows or hides the Status bar, which displays the current activity or 
state of the Avaya IP Softphone and ToolTips. 

Call Bar  Shows or hides the Call Bar window. If you hide the Call Bar 
window, you can view it by right-clicking the Avaya IP Softphone 
icon in the system tray, and selecting Call Bar. 

Picture of 
Phone 

 Shows or hides the Picture of Phone window. The Picture of Phone 
window displays a picture of your telephone. From this window, you 
can make and handle calls just as you would from the actual 
telephone. You can also change the labels of feature buttons and 
softkeys displayed in the Picture of Phone window. 
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Tools Menu 

The following table lists the Tools menu commands and a description of each command. 

Menu Command Submenu 
Command 

Description 

Phone Features  Opens the Phone Features window, which lists all call appearances 
and feature buttons administered on the telephone system for this 
phone. 

Personal Phone 
Features 

 Opens the Personal Phone Features window. 

Phone Directory  Opens the Phone Directory, which stores names, addresses, phone 
numbers, and other information. 

Speed Dial 
Numbers 

 Opens the Speed Dial Numbers window, which displays your existing 
Speed Dials. 

Call History  Opens the Call History log, which contains call history information 
including calling party name (for incoming calls), calling party number 
(for incoming calls), called party name (for outgoing calls), called 
party number (for outgoing calls), date, time, duration, and call notes. 

Screen Pops  Opens the Screen Pops window, which enables you to create and 
modify screen pops. 

Search Public 
Directory 

 Provides access to corporate or public directory services, enabling 
you to query and manage a database, such as a directory, over a 
TCP/IP connection. 

Program Options  Opens the Program Options dialog box, which enables you to 
administer various options, such as whether the Transfer button will 
perform a supervised transfer or an unsupervised transfer and 
whether to display Avaya IP Softphone on top of other windows. 
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Audio Menu 

The following table lists the Audio menu commands and a description of each command. 

Menu Command Description 

Volume and 
Ringer Settings 

Enables you to adjust the volume setting of the speakers, microphone, and 
ringer, set whether you want to hear your voice in your headset, and set 
whether to play ringing through the internal PC speaker. 

Options Enables you to set Avaya iClarity IP Audio options such as whether you are 
using a headset/handset or PC speakers and a microphone and the type of 
connection between your PC and the server (for example, LAN or modem). 

Tuning Wizard Starts the Tuning Wizard, which enables you to configure the audio settings 
for Avaya iClarity IP Audio. 

Monitor Displays information about the current service link connection between 
Avaya iClarity IP Audio and the server. 

Settings Menu 

The following table describes the Settings menu command. 

Menu Command Description 

Dialing Properties 
(Windows Me, 
Windows 98, and 
Windows NT) 

Phone and 
Modem Options 
(Windows 2000) 

Opens the Windows Dialing Properties dialog box (Windows Me, Windows 
98, and Windows NT) or Phone and Modem Options dialog box (Windows 
2000). When you dial a number from Avaya IP Softphone, the number will 
be formatted based on the information configured on the computer in the 
Dialing Properties or Phone and Modem Options dialog box. 

Language Enables you to select the language for Avaya IP Softphone. 

Login Settings Opens the Login Settings dialog box, which enables you to modify the Login 
settings, emergency call handling settings, VPN settings, and firewall 
settings. 

Login Wizard Starts the Login Wizard, which enables you to modify the Login settings. 

Login Status Opens the Login Status window, which indicates whether you are logged 
into the server, the current setting for the Emergency Call Handling feature, 
whether Avaya IP Softphone will attempt to log you into the server 
automatically every time you Avaya IP Softphone, and whether the Login 
Status window will open automatically when you log into the server. When 
you are logged into the server, the Login Status window also displays 
information about the current session. 
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Help Menu 

The following table lists the Help menu commands and a description of each command. 

Menu 
Command 

Description 

Contents Selecting Contents opens the Avaya IP Softphone on-line help table of 
contents. 

About Avaya 
IP Softphone 

Displays the copyright date and the version number for Avaya IP 
Softphone, the type of telephone you are logged in as, the extension you 
are logged into, the version number for Avaya iClarity IP Audio, and the 
version number of the server software. 
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Viewing the Panels and Status Bar 

Introduction 

The Avaya IP Softphone Call Bar window contains a panel at the bottom of the window that 
serves as the call appearance. You can also display another panel, the Phone Display Panel, 
by selecting Phone Display from the View menu. 

To display the status bar, select Status Bar from the View menu. 

Call Appearance 

The call appearance appears only during an incoming and outgoing call. It provides 
information about the call, such as call status, call display, call duration, and a control button 
(for example, Answer, Hangup, and Unhold). If the number associated with the call display 
is in the Phone Directory, the call display will contain the display name in the directory 
(instead of the display information from the telephone system). 

The call status—incoming, outgoing, or on hold—is displayed in the first section. 

An example of a call appearance is shown below: 

 

Phone Display Panel 

The Phone Display panel is a 40-character display that is located under the call appearance. 
This display area is updated automatically with information from the telephone system so that 
you can see call and non-call related information (for example, the local time/date display 
from the telephone system). 

Status Bar 

The status bar is located at the bottom of the Avaya IP Softphone main window and displays 
Avaya IP Softphone application status. It also displays a brief description of each of the 
toolbar buttons when the mouse pointer is over the button. If you have activated "Send All 
Calls," the default string will be changed from "Ready" to "Ready - Send All Calls Activated." 
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Displaying Toolbars and the Dial Pad 

Introduction 

The following toolbars are associated with the Avaya IP Softphone Call Bar window—Phone 
Buttons, Dial Number, Audio Control, Message Waiting, Login Options, and Audio Settings. 
These toolbars contain buttons that you can use for quick access to specific commands and 
tools. 

Phone Buttons Toolbar 

The Phone Buttons toolbar provides quick access to the following basic phone buttons: Drop, 
Hold, Transfer, and Conference. 

The Phone Buttons toolbar is shown below: 

 

Dial Number Toolbar 

From the Dial Number toolbar, you can: 

• dial numbers 

• send digits during the call 

• redial 

• access the Dial Pad window 

• access the Picture of Phone window 

• access the Phone Directory 

• access the Speed Dial list 

• access the recent calls list 

• access the Speed Dial Numbers window 

• access the Call History log 

• search a public directory 

The Dial Number toolbar is shown below: 
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Audio Control Toolbar 

The Audio Control toolbar enables you to adjust the volume for Avaya iClarity IP Audio. From 
this toolbar, you can: 

• mute your microphone 

• adjust the microphone volume 

• determine the audio channel direction 

• access the Audio Monitor dialog box, which displays the audio status 

• force transmit 

• mute your speaker 

• adjust the speaker volume 

• mute your ringer 

• mute the ringer volume 

The Audio Control toolbar is shown below: 

 
The Audio Control toolbar is only enabled when you use Avaya IP Softphone in the Road 
Warrior configuration (that is, voice over IP mode) with Avaya iClarity IP Audio. (This toolbar is 
disabled if you use Avaya IP Softphone in the Telecommuter configuration.) 

Message Waiting Toolbar 

The Message Waiting toolbar consists of one button that enables you to access your voice 
messaging system. 

The Message Waiting toolbar is shown below: 

 

Login Options Toolbar 

From the Login Options toolbar, you can: 

• log into the server (if you are not logged in currently) 

• log out of the server (if you logged in currently) 

• access the Login Settings dialog box in Avaya iClarity IP Audio. (You can only access 
this dialog box when you are not logged into the server.) From this dialog box, you can 
modify the following information: 

o login settings 

o server address(es) 

o audio configuration (for example, Road Warrior configuration or 
Telecommuter configuration) 

o call control application 

o emergency call handling settings 

o VPN configuration 

o firewall configuration 

• run the Login Wizard 
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The Login Options toolbar is shown below: 

 

Audio Settings Toolbar 

From the Audio Settings toolbar, you can: 

• modify the audio options for Avaya iClarity IP Audio 

• mute the speakers 

• adjust the volume setting for the speakers 

• specify whether you want to hear your voice in your headset 

• mute the microphone 

• adjust the volume setting for the microphone 

• adjust the volume setting of the ringer 

• specify whether you want the ringer to play through the internal PC speaker 

• run the Tuning Wizard 

The Audio Settings toolbar is shown below: 

 

Dial Pad 

The Dial Pad displays the numbers that are on a telephone dial pad. It contains 12 buttons 
that you use to dial a number and access features. You can access the Dial Pad by selecting 
Dial Pad from the View menu. 

The default Dial Pad is shown below: 

 
You can set the Dial Pad to appear without letters by disabling the Display letters on the Dial 
Pad setting in the User Interface Options in the Program Options dialog box. (You access 
the Program Options dialog box by selecting the Program Options command from the Tools 
menu.) 

NOTE: 
The first time you open the Dial Pad during an Avaya IP Softphone session, the Dial Pad 
appears next to the Avaya IP Softphone window. If you move the location of the Dial Pad and 
then close it, the Dial Pad will reappear in its last location the next time you open the Dial Pad 
during the current session. However, the Dial Pad will always appear in its default position 
(that is, next to the Avaya IP Softphone window) when you open the Dial Pad for the first time 
during an Avaya IP Softphone session. 
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Using Keyboard Accelerators 

Introduction 

Avaya IP Softphone provides keyboard accelerators for Windows Me, Windows 98, Windows 
NT, Windows Me, Windows 2000, and Windows XP. 

To display the keyboard accelerators in Windows 2000, press the ALT key. (In Windows 
2000, the ALT key toggles the display of the keyboard accelerators.) 
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Using a Headset with Avaya IP Softphone 

Introduction 

When using a headset with Avaya IP Softphone, be sure to place the microphone of the 
headset underneath your chin. This helps ensure that the other party on a call will hear you 
when you speak. 

For a list of supported headsets, go to http://avaya.com/support. 

 



 23 

Using Other Applications with Avaya IP Softphone 

Introduction 

If your database is in a contact manager application that is TAPI compliant or supports TAPI-
assisted dialing, you can place calls from that database through Avaya IP Softphone. If you 
want to use an application that is TAPI compliant or supports TAPI-assisted dialing, make 
sure you start Avaya IP Softphone and log into the server before making any calls. 
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Voice Quality Issues 
Voice quality is affected by the following factors: 

• the type of headset you are using 

• the type of sound device in your PC 

• the level of Quality of Service (QoS) support 

• the attributes of your network 

For the most up-to-date information regarding voice quality issues, go to the Troubleshooting 
page for Avaya IP Softphone at http://avaya.com/support.  
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Glossary 

Abbreviated Dial Feature 

Allows you to store selected telephone numbers for quicker and easier dialing. Each number 
can be a complete or partial telephone number, an extension number, or a trunk or feature 
code. 

ACP 

Avaya Call Processor. A telecommunications system that routes voice and data information 
between various endpoints (for example, telephones, terminals, and computers), provides 
highly robust networking capabilities, includes a set of standard features (for example, Voice 
Processing Interface, Call Coverage, and DS1/E1 Connectivity), and provides flexibility. It also 
allows for the addition of optional features and upgrades to the system as business needs 
change. 

Active Call 

A call appearance state where the voice (talk) path between two parties has been connected. 

Add/Remove Programs 

A Windows feature that allows you to remove programs that have been installed on your 
computer. The Add/Remove icon is found in the Control Panel dialog box. 

Application Folder 

A folder on the network server that holds Avaya IP Softphone application software-executable 
files and components. 

AutoPlay 

A Windows feature that causes an application on a CD-ROM to run without any user 
interaction as soon as the CD-ROM is inserted into the drive. 

Avaya IP Softphone 

Avaya IP Softphone enables you to log into your company's server remotely and make and 
receive telephone calls from your telephone extension. 

Basic Conference 

A conference option that allows you to add parties to a call as you would using the 
Conference button on your phone. (Basic Conference is available only in the Picture of Phone 
window.) For a Basic Conference, you open the Picture of Phone window, click the 
Conference button, dial the number of the party you want to add to the conference, talk to the 
party, and click the Conference button again. See also Enhanced Conference. 

Call Appearance 

The call appearance is a single panel (40-character display) that provides information about a 
single call, such as name, call duration, status icon, and control button (for example, Answer, 
Hangup, or Unhold). 

Call Information Panel 

The Call Information Panel (CIP) is a single panel (40-character display) that provides 
information about a single call, such as name, call duration, status icon, and control button (for 
example, Answer, Hangup, or Unhold). 



 26 

Call Park 

To park a call for retrieval at any extension. 

Call Pickup 

To answer a call to a member of your pickup group when your voice terminal is idle. 

Call Prompting 

A telephone system feature that routes incoming calls based on information entered by the 
calling party, such as an account number. The caller is prompted to select an option from 
those listed in an announcement. 

Cut-Through Dialing 

As a digit is entered, it is immediately dialed (as on a telephone). Cut-through dialing is 
provided using the Dial Pad or by entering digits from the keyboard when focus is not on the 
Number text box. 

DDE 

See Dynamic Data Exchange. 

DEFINITY ECS 

DEFINITY Enterprise Communications Server. The DEFINITY ECS is a telecommunications 
system that routes voice and data information between various endpoints (for example, 
telephones, terminals, and computers), provides highly robust networking capabilities, 
includes an extensive set of standard features (for example, Voice Processing Interface, Call 
Coverage, and DS1/E1 Connectivity), and provides flexibility. It also allows for the addition of 
optional features and upgrades to the system as business needs change. DEFINITY ECS is 
one of the ACP servers. 

Delimited Text File 

A file containing values separated by commas, tabs, semicolons, or other characters. 

Dial Area 

A frame located on the Avaya IP Softphone main window that provides dialing capabilities. 

Dial Pad 

A window containing 12 buttons that are used to dial a number. Each character clicked is 
automatically sent. This is called cut-through dialing. Using the Program Options command 
from the Tools menu, you can set the Dial Pad to appear without letters on the buttons. (You 
must disable the Display letters on the dial pad option in the Program Options dialog box.) 

Dial Number Button 

A button (telephone icon) on the Dial Number toolbar that is used to get a dial tone (for cut-
through dialing) or to dial the digits entered in the Number text box (senderized dialing). 

Dial Number Toolbar 

A toolbar that provides a number text box access to the phone directory, call history, speed 
dial, and recent calls list. When you enter a string (for example, rob) followed by Enter, a 
popup menu displays with a list of the directory entries that start with that string. If the first 
character of the number is a letter, the title of the field will be changed from Number to 
Directory. 
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DNS 

See Domain Naming System. 

Domain 

A subnetwork comprised of a group of clients and servers under the control of one security 
database. 

Domain Naming System (DNS) 

Software that lets users locate computers on the Internet by host name. The DNS server 
maintains a database of host names and IP addresses. 

Drop 

A button that allows you to disconnect from a call. The Drop button disconnects you from a 
call and gives you a dial tone. Use the Drop button when you want to disconnect from a call 
and place another call. You can also use the Drop button to disconnect the last person added 
to a conference call. 

Dynamic Data Exchange (DDE) 

A message protocol in Windows that allows application programs to request and exchange 
data between them automatically. 

Enhanced Conference 

A conference option that gives you more flexibility when adding parties to a conference. Unlike 
Basic Conference, Enhanced Conference enables you to speak to the party you want to add 
to the call, and then decide whether to add that party to the call. Enhanced Conference is 
available in the Call Bar window. See also Basic Conference. 

Eurofont 

A font set provided in DCP terminals that contains characters with diacritical marks common to 
other languages. Eurofont includes characters from the Russian, Greek, Baltic Rim, and 
central European languages, as well as the first 127 characters of the standard ANSI table. 
The True Type Font encoding used for Eurofont is non-standard relative to the encoding used 
in other Windows fonts. As a result, Avaya IP Softphone is able to support Eurofont characters 
in the displays received from the telephone system. 

FAC 

See Feature Access Code. 

Feature Access Code (FAC) 

A 1-to-4 digit number with an optional leading * or # that is assigned in the telephone system 
administration to invoke features. For example, *81 may invoke Service Observing Listen 
Only. FACs require an available call appearance with dial tone before the FAC can be sent to 
the telephone system. Assigned FACs may not be available to all users on the telephone 
system based on his/her class of restrictions and/or whether the feature has been enabled in 
the telephone system. 

Feature Button 

A button placed on the main window that can be assigned to any one of a number of 
telephone system features that could be assigned to a physical extension's button during 
station administration. 
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Graphical User Interface (GUI) 

This is a picture based, rather than command-line based, interaction between the user and the 
computer. 

Grayed Out 

When you do not have access to a menu or action list item, it will be grayed out (that is, 
dimmed or displayed in a different color from the rest of the menu or action list). The menu or 
action list item is disabled. 

GUI 

See Graphical User Interface. 

Hold 

Allows you to place the active call on hold temporarily, use the toolbar for other call purposes, 
and then return to the original call. 

HTML 

See HyperText Markup Language. 

Hypertext 

A linkage between related text. For example, if you select a word in a sentence, information 
about that word is retrieved if it exists, or the next occurrence of the word is found. 

HyperText Markup Language 

HTML. A standard for defining documents with hypertext links. See also Hypertext. 

Internet Protocol Address (IP Address) 

Each computer has its own unique IP address which is an identifier used for communicating 
across a network. 

IP Address 

See Internet Protocol Address. 

IT 

Information Technology. 

Kanafont 

A font set provided in DCP terminals that contains Katakana characters (used in Japanese 
language) as well as the first 127 characters of the standard ANSI table. The True Type Font 
encoding is non-standard relative to the encoding used on other Windows fonts. As a result, 
Avaya IP Softphone is able to support Katakana characters in displays received from the 
telephone system. 

LAN 

See Local Area Network. 

Local Area Network (LAN) 

A private interactive communication network that allows computers to communicate over short 
distances at high data transfer rates. 
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Log 

A file that contains a record of computer activity as well as backup and recovery data. 

Login 

Allows you to log into the server so that you can handle calls from Avaya IP Softphone. 

Login ID 

A user name on your company's LAN. 

Logout 

Allows you to log out of the server. When you log out of the server, you cannot handle calls 
with Avaya IP Softphone. 

Network Server 

A computer in a network shared by multiple users. 

Off-Hook 

Off-hook means that the voice path to your telephone is fully functional. 

On-Hook 

On-hook means that the voice path to your telephone is turned off. 

Phone Display 

A 40-character display that is located under the call appearance area of your Avaya IP 
Softphone Call Bar window. This display area receives information from the telephone system 
so that you can see call and non-call related information, such as call prompting digits from 
the telephone system. 

PSTN 

See Public Switched Telephone Network. 

Public Switched Telephone Network (PSTN) 

The worldwide voice telephone network. 

Readme File 

A file that provides the latest information on a newly released product; in this case, Avaya IP 
Softphone. 

Read-only 

A folder or file that can be read, but not updated or erased. 

Registry 

The system-wide depository of information supported by Windows. The registry contains 
information about the system and its applications, including clients and servers. 

Screen Pop 

The ability to automatically display information from other sources, such as databases or Web 
pages based on an Avaya IP Softphone triggering criteria. 
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Send All Calls 

To send all incoming calls (except priority, intercom, and personal central office calls) 
immediately to an assigned extension, AUDIX, or message center for coverage. 

Senderized Dialing 

When a dial string is entered, the Dial Number button or Enter key must be selected to 
actually dial the digits. This type of dialing allows for editing of dial strings before sending the 
digits. 

Softphone 

A software application that enables you to control telephone calls (both incoming and 
outgoing) directly from your computer. 

Supervised Transfer 

A transfer option that lets you send the present call to another phone number or extension. 
You remain on the line until the call is answered and talk to the party that receives the 
transferred call (if desired). You set the Supervised Transfer feature using the Call Handling 
option from the Program Options command of the Tools menu. See Unsupervised Transfer. 

Switch 

A private switching system providing voice-only or voice and data communications services 
(including access to public and private networks) for a group of terminals within a customer's 
premises (for example, a DEFINITY ECS). 

TAPI Assisted Dialing 

Avaya IP Softphone supports telephony enabled applications such as Microsoft Scheduler. 
This support provides the ability for telephony enabled Windows applications to originate a call 
and have the call reflected in the Avaya IP Softphone application. 

Toolbar 

A row of buttons used to activate various functions of the Avaya IP Softphone application. The 
Avaya IP Softphone main window can contain as many as six toolbars. 

Tool Tips 

Brief descriptions that display when the mouse pointer is over a toolbar button. 

Unsupervised Transfer 

A transfer option that lets you send the present call to another phone number or extension 
without talking to the party that will receive the transferred the call. You set the Unsupervised 
Transfer feature using the Call Handling option from the Program Options command of the 
Tools menu. See also Supervised Transfer. 

Voice Terminal 

A telephone equipped with specifically designed features (for example, the Conference or 
Hold button or Message light) and functional capabilities that distinguish it from a conventional 
telephone. 

VPN 

Virtual Private Network. 
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Running and Exiting Avaya IP Softphone 

Purpose 

Before you can use Avaya IP Softphone to handle calls, you must: 

1. Connect to your company's LAN (Local Area Network) where the server resides. 

2. Start Avaya IP Softphone. 

3. Log into the server via the Login dialog box. 

After you are logged into the server, you can use Avaya IP Softphone to handle calls. 

This section describes how to: 

• Start Avaya IP Softphone 

• Log into the server 

• Exit Avaya IP Softphone 
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Configure Your Login Settings 

Introduction 

Using the Login Wizard, you can modify your login settings. 

NOTE: 
You will be unable to configure the login settings while you are logged into the server. 

Procedure 

To configure your login settings: 

 
 

1 

 

Make sure you are not logged into the server. 

 

2 

Click the Login Wizard button. 

The Login Wizard dialog box appears. 

 

3 

Perform one of the following steps: 

• If you want to log into an Avaya server (Road Warrior configuration or 
Telecommuter configuration), click the Log into Avaya server option button. 

• If you want to log into an Avaya IP telephone, click the Log into Avaya IP 
Telephone option button. 

 

4 

Click the Next button. 

The next Login Wizard dialog box appears. 

 

5 
In the Extension box, enter your extension on the server. 

 

6 
In the Password box, enter your password. 

 

7 
If you want Avaya iClarity IP Audio to save your password for the next time you log into the 
server, make sure the Remember password for next login session check box is enabled. 

 



 33 

8 

Perform one of the following steps: 

• If you want to log into an Avaya server:  

1. In the Server Address box, enter the address of the server. 

2. Click the Next button. 

The Emergency Call Handling disclaimer dialog box appears. 

3. Go to Step 9. 

• If you want to log into an Avaya IP telephone:  

1. Click the Discover button to determine the IP address of the Avaya IP 
telephone, or enter the IP address of the Avaya IP telephone. 

2. Click the Next button. 

3. Go to Step 14. 

 

9 

If you agree with the information stated in the Emergency Call Handling disclaimer dialog 
box, click the I Agree button. 

The next Login Wizard dialog box appears. This dialog box enables you to configure Avaya 
iClarity IP Audio to use the Emergency Call Handling feature on your company's telephone 
system (if this feature is enabled for your extension). The Emergency Call Handling feature 
routes emergency calls (for example, 911 calls in the U.S.) to the appropriate emergency 
services destination. 

 

10 

Perform one of the following steps: 

• If you want to use the Emergency Call Handling feature, make sure the Enable 
emergency call handling feature check box is enabled, and perform one of the 
following steps: 

o If you are using Avaya iClarity IP Audio in your office (that is, you are 
located by your extension on your company's telephone system), select the 
Your extension number option button. 

o If you are using Avaya iClarity IP Audio away from your office (that is, you 
are working from a remote site, such as your home or a hotel), click the 
Telephone number option button, and enter the telephone number at your 
current location. 

• If you do not want to use the Emergency Call Handling feature, make sure the 
Enable emergency call handling feature check box is disabled. 

 

11 

Click the Next button. 

The next Login Wizard dialog box appears. This dialog box enables you to specify whether 
you will use your call control application (for example, Avaya IP Softphone) in the Road 
Warrior configuration (Voice over IP) or the Telecommuter configuration. 

 



 34 

12 

Perform one of the following steps: 

• If you want to use your application in the Road Warrior configuration, click the Road 
Warrior (Voice over IP) option button, and select how your PC connects to the 
server from the Bandwidth Setting box. (This is the network bandwidth setting.) 

• If you want to use your application in the Telecommuter configuration, click the 
Telecommuter option button, and enter the telephone number of the telephone you 
want to use. You will use the handset (or speakerphone) on this telephone to hear 
and speak to the other party on a call. Be sure to enter this telephone number the 
way you would dial it from your extension. 

For example, if the telephone number is an outside call in the same area code as your 
extension and you must dial a "9" when making outside calls, you would enter 9 at the 
beginning of the telephone number in this box. 

 

13 

When finished, click the Next button. 

A dialog box appears, informing you that you are finished configuring the login settings. 

 

14 
Click the Finish button. 
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Starting Avaya IP Softphone 

Procedure 

To start Avaya IP Softphone: 

 
 

1 
Log into your company's LAN. 

 

2 
Select Start from the taskbar. 

 

3 
Select Programs from the Start menu. 

 

4 
Select Avaya IP Softphone. 

 

5 

Select Avaya IP Softphone. 

The Avaya IP Softphone and the Login dialog box appear. Although Avaya IP Softphone is 
now running, you are not yet logged into the server. 

 

6 
Go to “Logging into the Server.” 
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Log into the Server Initially 

Introduction 

The procedure describes how to log into the server for the first time. 

Procedure 

To log into the server for the first time: 

 
 

1 
Make sure you are logged into your company's LAN. 

 

2 
Run the Login Wizard to configure your login settings. 

 

3 

After configuring your login settings, click the Log into the server button. 

The Login dialog box appears. 

 

4 
In the Extension box, verify your extension on the server. 

 

5 
In the Password box, enter your password. 

 

6 
In the Configuration box, specify whether you want to use the Road Warrior configuration 
(Voice over IP), the Telecommuter configuration, or the Avaya IP Telephone configuration. 

 

7 

Perform one of the following steps: 

• If you are using the Road Warrior configuration, make sure the address of the 
server is displayed in the Server Address box and the appropriate bandwidth setting 
is displayed in the Bandwidth Setting box. 

• If you are using the Telecommuter configuration, make sure the address of the 
server is displayed in the Server Address box and the telephone number of the 
telephone you want to use is displayed in the Telephone At box. 

• If you are using the Avaya IP Telephone configuration, make sure the IP address of 
the Avaya IP telephone is displayed in the IP Telephone Address box. 
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8 
If you want the software to save your password for the next time you log into the server, 
enable the Remember password for next login session check box. 

 

9 

If you want the software to try to log into the server automatically the next time you start 
Avaya iClarity IP Audio, enable the Automatically login if possible when application 
restarts check box. 

 

10 

Click the Log in button. 

NOTE: 
If you are using the Avaya IP Telephone configuration, perform the following steps: 

1. Look at the display of your IP telephone. 

The system prompts you to allow the remote login (CTI). 

2. Press the # button on the dialpad of the IP telephone to allow Avaya IP Softphone to 
log into the IP telephone. 

The Login Status dialog box appears when you log into the server successfully. 

The Login icon appears in the system tray. When you place the mouse over this icon, the 
extension you are logged in as and the status of the link to the server are displayed. 

Important! 

If you are using the Telecommuter configuration, the Verify Telephone Number dialog box 
appears. It is very important that you make some test calls before logging in, to verify that 
you have set up your connection properly. Click the OK button. 
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Logging into the Server 

Introduction 

Before you can use a call control application (for example, Avaya IP Softphone), you must log 
into the server. 

Procedure 

To log into the server: 

 

1 
Make sure you are logged into your company's LAN. 

 

2 

Click the Log into the server button. 

The Login dialog box appears. 

 

3 
In the Extension box, verify your extension on the server. 

 

4 
In the Password box, enter your password. 

 

5 
In the Configuration box, specify whether you want to use the Road Warrior configuration 
(Voice over IP), the Telecommuter configuration, or the Avaya IP Telephone configuration. 

 

6 

Perform one of the following steps: 

• If you are using the Road Warrior configuration, make sure the address of the 
server is displayed in the Server Address box and the appropriate bandwidth setting 
is displayed in the Bandwidth Setting box. 

• If you are using the Telecommuter configuration, make sure the address of the 
server is displayed in the Server Address box and telephone number of the 
telephone you want to use is displayed in the Telephone At box. 

• If you are using the Avaya IP Telephone configuration, make sure the IP address of 
the Avaya IP telephone is displayed in the IP Telephone Address box. 

 



 39 

 

7 
If you want the software to save your password for the next time you log into the server, 
enable the Remember password for next login session check box. 

 

8 

If you want the software to try to log into the server automatically the next time you start 
Avaya iClarity IP Audio, enable the Automatically login if possible when application 
restarts check box. 

 

9 

Click the Log in button. 

NOTE: 
If you are using the Avaya IP Telephone configuration, perform the following steps: 

1. Look at the display of your IP telephone. 

The system prompts you to allow the remote login (CTI). 

2. Press the # button on the dialpad of the IP telephone to allow Avaya IP Softphone to 
log into the IP telephone. 

The Login Status dialog box appears when you log into the server successfully. 

The Login icon appears in the system tray. When you place the mouse over this icon, the 
extension you are logged in as and the status of the link to the server are displayed. 

Important! 

If you are using the Telecommuter configuration, the Verify Telephone Number dialog box 
appears. It is very important that you make some test calls before logging in, to verify that 
you have set up your connection properly. Click the OK button. 
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Exiting Avaya IP Softphone 

Procedure 

This procedure describes how to exit Avaya IP Softphone and log out of the server. 

 
 

 

Perform one of the following steps: 

• From the File menu, select Exit. 

• Right-click the Avaya IP Softphone icon in the system tray, and select Exit. 
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Using the Telecommuter Configuration 

Introduction 

The Telecommuter configuration of Avaya IP Softphone enables telecommuters to use the 
full telephone system feature set from home. The Telecommuter configuration consists of a 
PC and a telephone with separate connections to the telephone system. The PC is 
connected to the telephone system over an IP network to provide the signaling path. The PC 
runs the Avaya IP Softphone software, providing you with an interface to control calls. A 
standard telephone is connected to the telephone system over the public-switched telephone 
network (PSTN) to provide a high-quality voice path. You place and receive calls via the IP 
Softphone interface on the PC and use the telephone handset to speak and listen. 

For the Telecommuter configuration, you must have a separate telephone line available at 
your location. You do not need an audio application such as Avaya iClarity IP Audio. When 
you receive or make a call after you start a Avaya IP Softphone session, a "service link" is 
established. This service link is the "audio path" that enables you to speak to the other party. 
In the Telecommuter configuration, the service link is established between the server and the 
telephone number you specified. If the service link is not established, you will be unable to 
make and receive calls. 

Requirements 

To use Avaya IP Softphone in the Telecommuter configuration, you will need: 

• access to your company's LAN (via dialup networking or a cable modem), which 
provides the signaling path between your PC running Avaya IP Softphone and your 
company's telephone system. 

• a separate telephone line, which you will use to speak to and hear the other party on a 
call. 

Logging In 

To log into the server using the Telecommuter configuration: 

  

1 
Make sure you are logged into your company's LAN. 

 

2 
In the Extension box of the Login dialog box, enter your extension on the server. 

 

3 
In the Password box, enter your password. 

 

4 
From the Configuration box, select Log into server as Telecommuter. 
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5 In the Server Address box, enter the address of the server. 

 

6 In the Telephone At box, enter the telephone number of the telephone you want to use. 
(This is the telephone number that the server calls to reach you for the voice connection.) 

You will use the handset (or speakerphone) on this telephone to hear and speak to the other 
party on a call. 

Important! 

Be sure to enter this telephone number the way you would dial it from your extension. For 
example, if the telephone number is an outside call in the same area code as your server 
and you must dial a 9 when making outside calls, you would enter 9 at the beginning of the 
telephone number in the Telephone at box. 

 

7 
If you want the software to save your password for the next time you log into the server, 
enable the Remember password for next login check box. 

 

8 

If you want the software to try to log into the server automatically the next time you start 
Avaya IP Softphone, enable the Automatically login if possible when application 
restarts check box. 

 

9 

Click the Log in button. 

The Verify Telephone Number dialog box appears. It is very important that you make some 
test calls before logging in, to verify that you have set up your connection properly. Click the 
OK button. 

The Login Status window appears when you log into the server successfully, and Avaya IP 
Softphone starts. 

The Login icon appears in the system tray. When you place the mouse over this icon, the 
extension you are logged in as and the status of the link to the server are displayed. 
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Things to Keep in Mind 

When using the Telecommuter configuration, keep in mind the following information: 

• If you receive an incoming call on your separate telephone line while you are active on 
a call with Avaya IP Softphone, that caller will hear either ringing (if you have call 
waiting on that line) or a busy signal. If you have call waiting, you can answer the 
incoming calls as you would answer any other call waiting call. 

• As long as the connection exists between the server and the telephone on your 
separate telephone line, you will be unable to make calls from this telephone. Calls 
can only be made from Avaya IP Softphone; the telephone is used only for voice 
transmission. (The telephone line is dedicated to transmitting the conversation 
between you and the other caller on the Avaya IP Softphone call.) Once the 
connection to the Avaya server ends, you can make calls from this telephone. 

• If you want to use telephone system features that require you to enter feature 
activation information (such as the Call Forwarding feature), you must enter this 
information from either your PC keyboard, the Dial Pad window, or the Phone of 
Phone window. Do not enter this information from the telephone on your 
separate line. 
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Using the Avaya IP Telephone Configuration 

Introduction 

The Avaya IP Telephone configuration of Avaya IP Softphone enables Avaya IP Telephone 
users to control their IP telephones from Avaya IP Softphone. In this configuration, you log 
into your Avaya IP Telephone instead of the server. Once you are logged into your IP 
telephone, you can make and handle calls from both Avaya IP Softphone and your IP 
telephone, and you use your IP telephone to speak and listen. For example, when a call 
arrives at your extension, you can either answer it from the Avaya IP Softphone window or 
your IP telephone. In this configuration, both Avaya IP Softphone and your IP telephone are 
"linked" during the session, enabling you to switch back and forth between the Avaya IP 
Softphone window and your IP telephone at any time as you make and handle calls. 

NOTE: 
When you use the Avaya IP Telephone configuration, you will be unable to mute your speaker 
and control the volume from the Avaya IP Softphone window. You must perform these actions 
from your IP telephone. 

For the Avaya IP Telephone configuration, you must have an Avaya 4606, 4612, 4620, 4624, 
or 4630 IP telephone that has the software that supports the remote login (CTI) feature. 
Contact your System Administrator to get the latest software for your IP telephone. 

Requirements 

To use Avaya IP Softphone in the Avaya IP Telephone configuration, you will need: 

• access to your company's LAN (via dialup networking or a cable modem), which 
provides the signaling path between your PC running Avaya IP Softphone and your IP 
telephone. 

• an Avaya 4606, 4612, 4620, 4624, or 4630 IP telephone that has the software that 
supports the remote login (CTI) feature. 

Logging In 

To log in using the Avaya IP Telephone configuration: 

  

1 
Make sure you are logged into your company's LAN. 

 

2 
In the Extension box of the Login dialog box, enter the extension of your IP telephone. 

 

3 
In the Password box, enter the password for your IP telephone. 

 

4 
From the Configuration box, select Log into Avaya IP Telephone. 
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5 

Perform one of the following steps: 

• Click the Discover button to determine the IP address of the Avaya IP telephone. 

• Enter the IP address of the Avaya IP telephone. 

 

6 
If you want the software to save your password for the next time you log in, enable the 
Remember password for next login check box. 

 

7 

If you want the software to try to log into the IP telephone automatically the next time you 
start Avaya IP Softphone, enable the Automatically login if possible when application 
restarts check box. 

 

8 
Click the Log in button. 

 

9 

Look at the display of your IP telephone. 

The system prompts you to allow the remote login (CTI). 

 

10 
Press the # button on the dialpad of your IP telephone to allow Avaya IP Softphone to log 
into the IP telephone. 

 

Things to Keep in Mind 

When using the Avaya IP Telephone configuration, keep in mind the following information: 

• You can start a procedure (such as dialing a number or adding participants to a 
conference) from Avaya IP Softphone and complete it from the IP telephone. 
(Conversely, you can start a procedure from the IP telephone and complete it from 
Avaya IP Softphone.) 

• You cannot mute your speaker and control the volume from the Avaya IP Softphone 
window. You must perform these actions from the IP telephone. 
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Using Avaya IP Softphone with a Virtual Private Network (VPN) 

Introduction 

This topic describes the requirements and procedure to log into a server using a VPN. You 
must follow the information provided in this topic if: 

• You are using a VPN tunnel and you have a "shim" VPN client running on your PC. 
(A "shim" VPN client is a software application that resides below the native TCP/IP 
stack of your PC and intercepts all network traffic that your PC transmits and 
receives.) 

• You are unable to log into your company's server using the “Logging into the Server” 
procedure. 

NOTE: 
Before you can log into Avaya IP Softphone, you must disable Internet Connection Sharing 
(ICS), Internet Connection Firewall (ICF), and all firewall applications running on the PC (for 
example, McAfee Personal Firewall Plus and Norton Personal Firewall). You must also disable 
the built-in firewall of your VPN client application (such as Lucent or Cisco). 

Requirements 

To use Avaya IP Softphone to log into a VPN, you will need: 

• access to your company's LAN 

• a VPN client application that provides the IP address (that is, the IPSec IP address) 
that is assigned to you by the VPN gateway. Contact your VPN provider or IT 
department for instructions on how to determine the IP address of your VPN client. 

NOTE: 
Avaya IP Softphone will NOT work with VPN gateways that implement port address 
translation. 

You must disable the built-in firewall of your VPN client application (such as Lucent or 
Cisco). 

Logging In 

To log in using a VPN: 

  

1 
Make sure you are logged into your company's LAN. 

 

2 
Open your VPN client application and determine the IP address assigned by the VPN 
gateway. If you cannot find this information, contact your Network Administrator. 

 

3 
Disable the built-in firewall of your VPN client application. 

 



 47 

 

4 
Disable the firewall application (if running) on your PC. 

 

5 
In the Extension box of the Login dialog box, enter your extension on the server. 

 

6 
In the Password box, enter your password. 

 

7 

In the Configuration box, specify whether you want to use Avaya IP Softphone in the Road 
Warrior configuration (Voice over IP) configuration, the Telecommuter configuration, or the 
Avaya IP Telephone configuration. 

 

8 

Perform one of the following steps: 

• If you are using the Road Warrior configuration, make sure the appropriate 
bandwidth setting is displayed in the Bandwidth Setting box. 

• If you are using the Telecommuter configuration, make sure the telephone number 
of the telephone you want to use is displayed in the Telephone At box. 

• If you are using the Avaya IP Telephone configuration, make sure the address of 
the IP telephone is displayed in the IP Telephone Address box. 

 

9 
If you want the software to save your password for the next time you log into the server, 
enable the Remember password for next login session check box. 

 

10 

If you want the software to try to log into the server automatically the next time you start 
Avaya IP Softphone, enable the Automatically login if possible when application 
restarts check box. 

 

11 

Click the Settings button. 

The Login Settings dialog box appears. The Login tab is selected. 
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12 

Click the Advanced tab. 

The Advanced tab appears. 

 

13 

Click the Use the following IP address check box in the Local IP Address Information area, 
and enter the IP address of your VPN client in the corresponding box. (The VPN gateway 
assigns the IP address to your VPN client.) 

 

14 

Perform one of the following steps: 

• If your company's VPN has a firewall using TCP and/or UDP port restrictions, 
perform the following steps: 

1. Contact your Telecommunications department or IT department to 
determine the port range allowed by the firewall. 

2. Click the Choose from the following port range to communicate with 
the server check box in the Local Port Range Information area. 

3. In the Lowest port number box, enter the number of the lowest port you 
want Avaya IP Softphone to use. This number must be greater than 1024 
and less than 65436. 

4. In the Highest port number box, enter the number of the highest port you 
want Avaya IP Softphone to use. This number must be less than 65536. 

NOTE: 
The minimum range between the lowest port number and the highest port 
number is 100 ports (that is, the range you enter must consist of 100 or 
more port numbers). 

5. Go to Step 15. 

• If your company's VPN does not have a firewall, go to Step 15. 

 

15 
Click the OK button. 

 

16 

Click the Log in button. 

The VPN Configuration in Effect dialog box appears. 

 

17 
Click the Continue with the current settings option button. 
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18 

Click the OK button. 

NOTE: 
If you are using the Avaya IP Telephone configuration, perform the following steps:  

1. Look at the display of your IP telephone. 

The system prompts you to allow the remote login (CTI). 

2. Press the # button on the dialpad of the IP telephone to allow Avaya IP Softphone 
to log into the IP telephone. 

The Login Status dialog box appears when you log into the server successfully, and Avaya 
IP Softphone starts. 

The Login icon appears in the system tray. When you place the mouse over this icon, the 
extension you are logged in as and the status of the link to the server are displayed. 

Important! 

If you are using the Telecommuter configuration, the Verify Telephone Number dialog box 
appears. It is very important that you make some test calls before logging in, to verify that 
you have set up your connection properly. Click the OK button. 
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Using Avaya IP Softphone with a Firewall 

Introduction 

This topic describes the requirements and procedure to log into a server that uses a firewall 
with TCP and/or UDP port restrictions. Follow the information provided in this topic only if you 
have been unable to log into your company's server using the “Logging into the Server” 
procedure. 

Requirements 

To use Avaya IP Softphone with a firewall, you will need: 

• access to your company's LAN 

• the port range allowed by the firewall. (Contact your Telecommunications department 
or IT department for this information.) 

NOTE: 
Before you can log into Avaya IP Softphone, you must disable Internet Connection Sharing 
(ICS), Internet Connection Firewall (ICF), and all firewall applications running on the PC (for 
example, McAfee Personal Firewall Plus and Norton Personal Firewall). If you are using a 
VPN client (such as Lucent or Cisco), you must also disable its built-in firewall. 

Logging In 

To log in with a firewall: 

 
 

1 
Make sure you are logged into your company's LAN. 

 

2 
Disable the firewall application (if running) on your PC. 

 

3 
In the Extension box of the Login dialog box, enter your extension on the server. 

 

4 
In the Password box, enter your password. 

 

5 

In the Configuration box, specify whether you want to use Avaya IP Softphone in the Road 
Warrior configuration (Voice over IP) configuration, the Telecommuter configuration, or the 
Avaya IP Telephone configuration. 
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6 

Perform one of the following steps: 

• If you are using the Road Warrior configuration, make sure the appropriate 
bandwidth setting is displayed in the Bandwidth Setting box. 

• If you are using the Telecommuter configuration, make sure the telephone number 
of the telephone you want to use is displayed in the Telephone At box. 

• If you are using the Avaya IP Telephone configuration, make sure the address of 
the IP telephone is displayed in the IP Telephone Address box. 

 

7 
If you want the software to save your password for the next time you log into the server, 
enable the Remember password for next login session check box. 

 

8 

If you want the software to try to log into the server automatically the next time you start 
Avaya IP Softphone, enable the Automatically login if possible when application 
restarts check box. 

 

9 

Click the Settings button. 

The Login Settings dialog box appears. The Login tab is selected. 

 

10 

Click the Advanced tab. 

The Advanced tab appears. 

 

11 
Click the Choose from the following port range to communicate with the server check 
box in the Local Port Range Information area. 

 

12 
In the Lowest port number box, enter the number of the lowest port you want Avaya IP 
Softphone to use. This number must be greater than 1024 and less than 65436. 
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13 

In the Highest port number box, enter the number of the highest port you want Avaya IP 
Softphone to use. This number must be less than 65536. 

NOTE: 
The minimum range between the lowest port number and the highest port number is 100 
ports (that is, the range you enter must consist of 100 or more port numbers). 

 

14 
Click the OK button. 

 

15 

Click the Log in button. 

The VPN Configuration in Effect dialog box appears. 

 

16 
Click the Continue with the current settings option button. 

 

17 

Click the OK button. 

NOTE: 
If you are using the Avaya IP Telephone configuration, perform the following steps: 

1. Look at the display of your IP telephone. 

The system prompts you to allow the remote login (CTI). 

2. Press the # button on the dialpad of the IP telephone to allow Avaya IP Softphone 
to log into the IP telephone. 

The Login Status dialog box appears when you log into the server successfully, and Avaya 
IP Softphone starts. 

The Login icon appears in the system tray. When you place the mouse over this icon, the 
extension you are logged in as and the status of the link to the server are displayed. 

Important! 

If you are using the Telecommuter configuration, the Verify Telephone Number dialog box 
appears. It is very important that you make some test calls before logging in, to verify that 
you have set up your connection properly. Click the OK button. 
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Login Issues 

Introduction 

Follow the information provided in this topic if you have been unable to log into your 
company's server or your Avaya IP telephone. 

Things to Keep in Mind 

If you are unable to log into the server or IP telephone, do the following: 

1. If you are using the Avaya IP Telephone configuration, verify that the IP telephone you 
want to log into is an Avaya 4606, 4612, 4620, 4624, or 4630 IP telephone that has 
the software that supports the remote login (CTI) feature. Contact your System 
Administrator to get the latest software for your IP telephone. 

2. Disable Internet Connection Sharing (ICS), Internet Connection Firewall (ICF), and all 
firewall applications on your PC. 

3. If your company's LAN uses a firewall, configure iClarity IP Audio for use with a 
firewall. 

4. If you are using a VPN, configure iClarity IP Audio for use with a VPN. 

If you are still unable to login, go to the Troubleshooting page for Avaya IP Softphone at 
http://avaya.com/support for more information. 
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Handling Calls with Avaya IP Softphone 

Introduction 

When you receive or make a call after you start a Avaya IP Softphone session, a "service 
link" is established. This service link is the "audio path" that enables you to speak to the other 
party. If you are using the Road Warrior configuration, the service link is established between 
the server and Avaya iClarity IP Audio. If you are using the Telecommuter configuration, the 
service link is established between the server and the telephone number you specified. If the 
service link is not established, you will be unable to make and receive calls. The action you 
must perform to establish the service link depends on the Avaya IP Softphone configuration 
you are using. 

Depending on how your login on the server is administered, the service link will either: 

• be disconnected when the current call ends, or 

• remain connected for the duration of the current Login session. 

Avaya IP Softphone can be administered to support the following service link calls: 

• per-call (as needed) service link 

When the telephone System Administrator sets the service link to be on a per-call 
basis (or as needed) for your account, the service link that is established the first time 
you make or receive a call during the current session remains active for the duration 
of the current call. Shortly after the current call ends, the service link ends. If you 
make or receive a call while the service link is still established, Avaya IP Softphone 
uses the existing service link. 

• permanent service link 

When the telephone System Administrator sets the service link to be permanent for 
your account, the service link that is established the first time you make or receive a 
call during the current session remains active until you log out of the server. 

Using the Road Warrior Configuration 

If you are using the Road Warrior configuration with Avaya iClarity IP Audio, the service link 
call is answered automatically. 

To make a call using Avaya iClarity IP Audio in the Road Warrior configuration, you must 
perform the following step: 

• Make a call from the Avaya IP Softphone window. 

A service link call is made from the server to Avaya iClarity IP Audio . Even though 
you have made a call from Avaya IP Softphone, the call is not placed until the service 
link is established. Avaya iClarity IP Audio answers the service link call automatically. 
The service link call is established, and the outgoing call is placed. You will hear the 
call ring at the destination telephone number. 

When you receive an incoming call, the server tries to establish the service link to Avaya 
iClarity IP Audio. The service link call is answered automatically. To answer a call using 
Avaya iClarity IP Audio, just choose the Answer button for the call in the Avaya IP Softphone 
window. The incoming call is answered, and you can speak to the other party. 
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Using the Telecommuter Configuration 

If you are using the Telecommuter configuration, Avaya IP Softphone places the service link 
call to the telephone line you specified. You must answer the service link call by answering 
the telephone connected to the telephone number you specified. 

To make a call in the Telecommuter configuration, you must perform the following steps: 

1. Make a call from the Avaya IP Softphone window. 

A service link call is made from the server to the telephone number you specified. 
Even though you have made a call from Avaya IP Softphone, the call is not placed 
until the service link is established. 

2. Answer the call on your separate telephone line. 

The service link call is established, and the outgoing call is placed. You will hear the 
call ring at the destination telephone number. 

When you receive an incoming call, the server tries to establish the service link to the 
separate telephone line you specified. To answer a call in the Telecommuter configuration, 
you must answer the service link call on the separate telephone line you specified. The 
incoming call is answered, and you can speak to the other party. 

Using the Avaya IP Telephone Configuration 

In the Avaya IP Telephone configuration, you can make calls and answer calls from both 
Avaya IP Softphone and your IP telephone. 
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Answer a Call 

Introduction 

A ringing call is displayed in the Call Appearance area of the Avaya IP Softphone window 
with a call label and the calling number. The Answer button appears next to the call 
appearance. 

When you answer a call, the Answer button for the call appearance becomes the Hangup 
button, and the Active Timer starts. The Active Timer keeps track of the duration of the call. 

If you are active on a call and answer another call, the active call is placed on hold 
automatically, and the ringing call becomes active. 

Procedure 

To answer a call: 

 
 

 

Choose the Answer button for the associated call appearance. 

If you are using a separate telephone line, answer the call from the phone. 
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Hang up a Call 

Introduction 

Clicking the Hangup button for a call appearance disconnects the call. This action is similar 
to hanging up the handset or turning off the Speakerphone on your telephone. 

You can only hang up active calls. 

If you want to disconnect a call and then hear dial tone, use the Drop button. 

Procedure 

To hang up a call: 

 
 

1 

Choose the Hangup button for the associated call appearance. 

The call is disconnected, and the information for the call is removed from the call appearance. 

If you are using the speakerphone, the speakerphone turns off. 

 

2 
If you are using the handset, hang it up. 
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Drop a Call 

Introduction 

Clicking the Drop button disconnects the active call. After the call is dropped, the telephone 
system provides dial tone. 

You can only drop active calls. 

Procedure 

To drop the active call: 

 
 

 

Choose the Drop button from the Phone Buttons toolbar. 

The active call is disconnected, and the associated call appearance is removed. The 
telephone system provides dial tone after the call is dropped. 
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Answer a Call on Hold 

Introduction 

When you answer a call that is on hold, the Unhold button for that call appearance becomes 
the Hangup button, and the Active Timer resumes. The Active Timer keeps track of the 
duration of the call. 

If you are active on a call and answer a call that is on hold, the active call is placed on hold 
automatically, and the held call becomes active. 

Procedure 

To answer a call that is on hold: 

 
 

 

Choose the Unhold button for the associated call appearance or double-click on the call 
appearance. 

The call becomes active, and the Hangup button appears on the associated call appearance. 
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Place a Call on Hold 

Introduction 

When you place a call on hold, the Hangup button for that call appearance becomes the 
Unhold button, and the Hold Timer starts. The Hold Timer keeps track of how long the call is 
on hold. The Hold Timer restarts every time the call is placed on hold. 

You can only place the active call on hold. 

Procedure 

To place the active call on hold: 

 
 

 

Choose the Hold button. 

The active call is placed on hold, and the Unhold button appears for the call appearance. 
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Enter Digits during a Call 

Introduction 

Using Avaya IP Softphone, you can send digits during an active call. These digits are sent 
immediately (that is, as you type them). You cannot edit these digits. 

You can enter digits from your keyboard or from the Dial Pad window. 

Enter digits from your keyboard 

To send digits from your keyboard during a call: 

 
 

1 
Make sure the Avaya IP Softphone window is active (that is, the window is selected). 

 

2 

Type the characters you want to send. 

Avaya IP Softphone sends these characters as you type them. 

 

Enter digits from the Dial Pad window 

To send digits from the Dial Pad window during a call: 

 
 

1 

From the View menu, select Dial Pad. 

The Dial Pad window appears 

 

2 

Click on the appropriate buttons in the Dial Pad window. 

Avaya IP Softphone sends these characters as you click on them. 
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Transfer a Call 

Introduction 

There are four methods of transferring calls: 

• Unsupervised Transfer from the Call Bar window (that is, the Avaya IP Softphone 
main window) 

You click the Transfer button on the Phone Buttons toolbar, type the number to be 
called into a text box, and click the OK button to transfer the call. You do not 
announce the call. 

• Supervised Transfer from the Call Bar window 

You click the Transfer button on the Phones Buttons toolbar, type the number to be 
called into a text box, and click the OK button. After announcing the call, you can 
either click the Yes button to transfer or the No button to not transfer the call. 

• Drag and Drop Transfer from the Call Bar window 

You transfer a call by placing the call on hold and then dragging and dropping the call 
appearance for that call onto the active call appearance of the destination to which 
you want to transfer the call. 

• Transfer from the Picture of Phone window 

You transfer the call as you would from your telephone. 

You specify which type of transfer (that is, Unsupervised Transfer or Supervised Transfer) you 
want the Transfer button in the Phone Buttons toolbar to perform using the Call Handling 
option from the Program Options command of the Tools menu. See “Configuring Avaya IP 
Softphone Options.” 
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Unsupervised Transfer 

To transfer a call using Unsupervised Transfer: 

 
 

1 

While you are active on a call, click the Transfer button. 

The Transfer dialog box appears. 

 

2 

Perform one of the following steps: 

• If you want to transfer the call to a new call, click the New Number option button, and 
enter the number to which you want to transfer the call. You can type in the number 
via your keyboard or paste it in from the Windows Clipboard. 

• If you want to transfer the call to an existing call, click the Existing Call option button, 
and select the call to which you want to transfer the call. 

 

3 

Click the OK button to transfer the call. 

The call appearance disappears from the IP Softphone window, indicating that the transfer 
was successful. 
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Supervised Transfer 

You can perform a Supervised Transfer using either the Transfer button on the toolbar or the 
mouse. 

To transfer a call using Supervised Transfer: 

 
 

1 

While you are active on a call, click the Transfer button. 

The Transfer dialog box appears. 

 

2 

Perform one of the following steps: 

• If you want to transfer the call to a new call, click the New Number option button, and 
enter the number to which you want to transfer the call. You can type in the number 
via your keyboard or paste it in from the Windows Clipboard. 

• If you want to transfer the call to an existing call, click the Existing Call option button, 
and select the call to which you want to transfer the call. 

 

3 

Click the OK button. 

The call you want to transfer is placed on hold automatically, a new call appearance appears, 
you hear dial tone, and the Transfer dialog box appears. 

 

4 
Click the Yes button in the Transfer dialog box to transfer to the call. 
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Drag and Drop Transfer 

Performing a transfer using the mouse is helpful when you are currently speaking to the 
person to whom you want to transfer the call. 

To transfer a call using the mouse: 

 
 

1 
Make sure there is an existing call appearance for the destination to which you want to 
transfer the call. 

 

2 
Place on hold the call you want to transfer. 

 

3 

Answer the call appearance for the transfer destination. 

The call becomes active. 

 

4 
Press and hold down the mouse button on the name/number field of the call you placed on 
hold. 

 

5 

Drag the call appearance onto the active call appearance of the transfer destination, and then 
release the mouse button. 

A menu appears. 

 

6 

Select Transfer. 

The Transfer dialog box appears. 

 

7 

Click the Yes button. 

The call is transferred. 
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Transfer from the Picture of Phone window 

To transfer a call using the Picture of Phone window: 

 
 

1 
Make sure the Picture of Phone window is open. 

 

2 

While you are active on a call, click the Transfer button in the Picture of Phone window. 

The call you want to transfer is placed on hold automatically, and you hear dial tone. 

 

3 
Using the phone's dial pad in the Picture of Phone window, click on the digits you want to dial. 

 

4 

When the second call is answered, you can privately talk to the party. When you are ready to 
complete the transfer, click the Transfer button in the Picture of Phone window. 

Tip: You may complete the transfer at anytime while the second call is ringing or after the 
second party answers the call. 
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Using the Picture of Phone Window 

Introduction 

The Picture of Phone window provides a simulation of your telephone. From this window, you 
handle calls just as you would from your telephone. You can also change the labels of the 
feature buttons and softkeys displayed in the Picture of Phone window. 

Handle Calls 

To handle calls from the Picture of Phone window: 

 
 

1 

Perform one of the following steps: 

• Click the Picture of Phone button on the Dial Number toolbar in the Avaya IP 
Softphone Call Bar window. 

• Right-click on the Avaya IP Softphone icon in the system tray, and select Picture of 
Phone. 

The Picture of Phone window appears. 

 

2 
Using the buttons in the Picture of Phone window, handle calls the same way as you would 
from your telephone. 
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Change the Feature Button Labels 

To change the labels of the feature buttons displayed in the Picture of Phone window: 

 
 

1 

Perform one of the following steps: 

• Click the Picture of Phone button on the Dial Number toolbar in the Avaya IP 
Softphone Call Bar window. 

• Right-click on the Avaya IP Softphone icon in the system tray, and select Picture of 
Phone. 

The Picture of Phone window appears. 

 

2 
Click . 

The labels you can modify are highlighted. 

 

3 
Click on the label you want to change, and make your changes. 

 

4 
Repeat Step 3 for any other labels you want to change. 

 

5 When you are finished, click . 
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Change the Softkey Labels 

To change the labels of the softkeys displayed in the Picture of Phone window: 

 
 

1 

Perform one of the following steps: 

• Click the Picture of Phone button on the Dial Number toolbar in the Avaya IP 
Softphone Call Bar window. 

• Right-click on the Avaya IP Softphone icon in the system tray, and select Picture of 
Phone. 

The Picture of Phone window appears. 

 

2 

Click Menu button. 

The softkey labels are displayed. 

 

3 
Click . 

The labels you can modify are highlighted. 

 

4 
Click on the label you want to change, and make your changes. 

 

5 
Repeat Step 4 for any other labels you want to change. 

 

6 When you are finished, click . 
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Make a Call from a Speed Dial 

Introduction 

Avaya IP Softphone lets you create speed dial numbers in the Phone Directory Properties 
dialog box. A speed dial number can be any number in the Phone Directory, up to a 
maximum of 25 numbers. 

Using the Dial Number Toolbar 

To make a call from a Speed Dial using the Dial Number toolbar: 

 
 

1 

In the Avaya IP Softphone Call Bar window, click the down arrow next to the Phone Directory 
button on the Dial Number toolbar. 

The speed dial list appears. 

 

2 

Click the number you want to dial. 

If you are using a separate telephone line, answer the call from the phone. 

Avaya IP Softphone places the call. A call appearance is displayed for the call. 

 

Using the Speed Dial Numbers window 

To make a call from the Speed Dial Numbers window: 

 
 

1 

Open the Speed Dial Numbers window. You can open the Speed Dial Numbers window by: 

• Clicking the Speed Dials button on the Dial Number toolbar in the Avaya IP 
Softphone Call Bar window. 

• Right-clicking on the Avaya IP Softphone icon in the system tray and selecting Speed 
Dial Numbers. 

The Speed Dial Numbers window appears. 

 

2 

Click the Speed Dial you want to dial, and click the Dial Number button. 

If you are using a separate telephone line, answer the call from the phone. 

Avaya IP Softphone places the call. A call appearance is displayed for the call. 
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Make a Call from the Speed Dial Numbers Window 

Introduction 

The Speed Dial Numbers window displays all of the Speed Dials that you have created in the 
Phone Directory. From this window, you can make calls from your Speed Dials.  

When you make a call from a Speed Dial, a call appearance is displayed in the Call 
Appearance area of the Avaya IP Softphone window. If you are active on a call and make 
another call, the active call is placed on hold automatically, and the new call becomes active. 

Procedure 

To make a call from the Speed Dial Numbers window: 

 
 

1 

Open the Speed Dial Numbers window. You can open the Speed Dial Numbers window by: 

• Clicking the Speed Dials button on the Dial Number toolbar in the Avaya IP 
Softphone Call Bar window. 

• Right-clicking on the Avaya IP Softphone icon in the system tray and selecting Speed 
Dial Numbers. 

The Speed Dial Numbers window appears. 

 

2 

Click the Speed Dial you want to dial, and click the Dial Number button. 

If you are using a separate telephone line, answer the call from the phone. 

Avaya IP Softphone places the call. A call appearance is displayed for the call. 
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Make a Call from a Phone Directory Entry 

Introduction 

You can store names, addresses, email addresses, notes, and phone numbers in the Phone 
Directory. The directory will support multiple numbers for each entry. 

The directory entries can be displayed with the following views: large icons, small icons, list, 
and detailed. In the detailed view, the entry's name, number, email, category, and notes are 
listed. The number displayed in this view is the first number found for the entry if multiple 
numbers are entered. The directory entries can be sorted by name, number, or category. 

Procedure 

To make a call from a Phone Directory entry: 

 
 

1 

In the Avaya IP Softphone Call Bar window, click the Phone Directory button on the Dial 
Number toolbar. 

The Phone Directory window appears. 

 

2 

Double-click the name in the directory list for the person you want to call. 

If the name in the directory entry has more than one number, a popup menu with a list of 
numbers appears. Select the appropriate telephone number from the popup menu. 

If you are using a separate telephone line, answer the call from the phone. 

Avaya IP Softphone places the call. A call appearance is displayed for the call. 
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Make a Call from the Dial Number Box 

Introduction 

When you make a call from the Dial Number box in the Dial Number toolbar, a call 
appearance is displayed in the Call Appearance area of the Avaya IP Softphone window. 
This call appearance displays the telephone number you entered in the Dial Number box. 
The information displayed in the call appearance is overwritten by any name information 
provided by your company's telephone system. 

NOTE: 
When you dial make a call from the Dial Number box, the telephone number you enter will be 
processed according to how you configured Windows dialing. 

If you are active on a call and make another call, the active call is placed on hold 
automatically, and the new call becomes active. 

Procedure 

To make a call from the Dial Number box: 

 
 

1 
In the Dial Number box, enter the telephone number you want to dial. 

 

2 

Click the Dial Number button or press the ENTER key on your keyboard. 

If you are using a separate telephone line, answer the call from the phone. 

Avaya IP Softphone places the call. A call appearance is displayed for the call. 
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Make a Call from the Picture of Phone Window 

Introduction 

The Picture of Phone window provides a simulation of your telephone. From this window, you 
make calls just as you would from your telephone. 

NOTE: 
Make sure you hear dial tone before dialing any digits. 

Procedure 

To make a call from the Picture of Phone window: 

 
 

1 

Open the Picture of Phone window. To open the Picture of Phone window, perform one of the 
following steps: 

• Select Picture of Phone from the View menu in the Call Bar window. 

• Click the Picture of Phone button on the Dial Number toolbar in the Call Bar window. 

• Right-click the mouse on the Avaya IP Softphone icon in the system tray, and select 
Picture of Phone. 

The Picture of Phone window appears. 

 

2 

Click one of the following buttons: 

• the call appearance button you want to use 

• the Handset button 

• the Speaker button 

If you are using a separate telephone line, answer the call from the phone. 

A call appearance is displayed for the call, and you will hear dial tone from the telephone 
system. 

 

3 

Using the phone's dial pad in the Picture of Phone window, click on the digits you want to dial. 

NOTE: 
Make sure your hear dial tone before dialing any digits. 

Avaya IP Softphone places the call. 
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Dial a Number from Another Application 

Introduction 

With Avaya IP Softphone, you can dial numbers that are stored in other applications. 

Procedure 

To dial a number from another application: 

 
 

1 

Select the telephone number you want to dial, right-click the mouse on the selected number, 
and select Copy. 

The selected number is highlighted. 

 

2 

Right-click the mouse on the Avaya IP Softphone icon in the system tray, and select Dial. 

If you are using a separate telephone line, answer the call from the phone. 

Avaya IP Softphone places the call. A call appearance is displayed for the call. 
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Redial the Last Number Dialed 

Introduction 

The Redial button dials the last telephone number that you dialed from Avaya IP Softphone 
during the current session. When you make a call using the Redial button, a call appearance 
is displayed in the Call Appearance area of the Avaya IP Softphone window. This call 
appearance displays the telephone number. The information displayed in the call appearance 
is overwritten by any name information provided by your company's telephone system. 

If you are active on a call and make another call, the active call is placed on hold 
automatically, and the new call becomes active. 

Procedure 

To redial the last number dialed: 

 
 

1 
Click the Redial button. 

 

2 

If you are using a separate telephone line, answer the call from the phone. 

Avaya IP Softphone places the call. A call appearance is displayed for the call. 
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Using Conferencing 

Introduction 

Depending on your telephone system, you may have up to six participants (including 
yourself) in a conference. 

Avaya IP Softphone supports the following three methods of handling conference calls: 

• Conference from the Call Bar window (that is, the Avaya IP Softphone main 
window) 

You click the Conference button on the Phone Buttons toolbar, type the number of 
the party to be added into a text box, and click the OK button. After talking to the 
party, you can either click the Yes button to add or the No button to not add the party 
to the call. 

• Conference from the Picture of Phone window (Basic Conference) 

You initiate and manage the conference as you would from your telephone. This is a 
Basic Conference. 

• Drag and Drop Conference from the Call Bar window 

You add another party to a call by placing the call you want to add on hold and 
dragging and dropping the call appearance for that call onto the active call 
appearance. 

Conference from the Call Bar window 

To add another person to a call or conference a call: 

  

1 

While you are active on a call, click the Conference button. 

The Conference dialog box appears. 

 

2 

In the Number box, enter the telephone number of the party you want to add to the call. 

Important! 

The number must be typed in, or it can be copied and pasted in. 

 

3 

Click the OK button. 

The caller is automatically put on hold and a new call is placed to the telephone number you 
entered. A call appearance appears for the new call, and the Conference dialog box appears. 
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4 

Perform one of the following steps: 

• If the call is answered, you can talk privately to the party. To add the party to the call, 
click the Yes button in the Conference dialog box. 

One call appearance appears displaying "CONFERENCE 2" (indicating an active 
conference). 

• If the call is not answered or is busy, click the No button in the Conference dialog box, 
and then click the Unhold button to return to the original party 

 

5 

Repeat steps 1 through 4 until you have conferenced all parties. 

The single call appearance will display “CONFERENCE X,” where X equals the number of 
parties that were added to the call. 

Example: 

If three parties were added to the call, the display on the call appearance will say 
“CONFERENCE 3.” 

Any person on the conference call can hang up at any time. The call appearance will display 
"CONFERENCE X," where X equals the number of parties left on the call. 

To disconnect the last person added to the conference call, click the Drop button. 

 

6 
When the conference call is over, click the Hangup button. 
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Conference from the Picture of Phone window (Basic Conference) 

To add another person to a call or conference a call: 

 
 

1 
Make sure the Picture of Phone window is open. 

 

2 

While you are active on the call to be conferenced, click the Conference button in the Picture 
of Phone window. 

The caller is automatically put on hold, and you hear dial tone. 

 

3 
Using the phone's dial pad in the Picture of Phone window, click on the digits you want to dial. 

 

4 

When the second call is answered, you can privately talk to the party; then select the 
Conference button again to initiate the conference call. 

Tip: You may initiate the conference at any time after the number is entered, during the 
ringing state, or after the second party answers. 

 

5 

Repeat steps 2 through 4 until you have conferenced all parties. 

The single call appearance will display "CONFERENCE X," where X equals the number of 
parties that were added to the call. 

Example: 

If three parties were added to the call, the display on the call appearance will display  
"CONFERENCE 3." 
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Drag and Drop Conference 

You can conference two individual calls or add a call to a conference by dragging the held 
call appearance onto the active call appearance and releasing the mouse button. You can 
only perform this procedure from the Call Bar window. 

To add another person to a call or conference a call using the mouse: 

 
 

1 
Place on hold the call you want to add to the conference. 

 

2 

Answer the call appearance for the conference call. 

The call becomes active. 

 

3 
Press and hold down the mouse button on the name/number field of the call you placed on 
hold. 

 

4 

Drag the call appearance onto the active call appearance of the conference, and then release 
the mouse button. 

A menu appears. 

 

5 

Click the Conference button. 

The Conference dialog box appears. 

 

6 

Click the Yes button. 

The call is conferenced. 
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Place a Conference on Hold 

Introduction 

When you place a conference on hold: 

• The other participants can continue talking. 

• You may make and answer calls. 

• The conference call is placed on hold automatically when you answer a call or make 
a call. 

Procedure 

To place a conference on hold: 

  

 

Choose the Hold button. 

The conference is placed on hold, and the Unhold button appears for the associated call 
appearance. 
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Answer a Conference on Hold 

Introduction 

When you answer a conference that is on hold, the Unhold button becomes the Hangup 
button for the call appearance of the conference, and the Active Timer resumes. The Active 
Timer keeps track of the duration of the call. 

If you are active on a call and answer a call that is on hold, the active call is placed on hold 
automatically, and the held call becomes active. 

Procedure 

To answer a conference that is on hold: 

 
 

 

Choose the Unhold button for the associated call appearance of the conference or double-
click on the call appearance. 

The conference becomes active, and the Hangup button appears for the associated call 
appearance. 
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Drop the Last Call from a Conference 

Introduction 

This procedure enables you to drop the last call that was added to the conference. 

The conference must be active when you want to drop the last call. 

Procedure 

To drop the last call from a conference: 

 
 

 

While the conference is active, choose the Drop button from the Phone Buttons toolbar. 

Avaya IP Softphone disconnects the last call that was added to the conference. 
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Hang up a Conference 

Introduction 

This procedure describes how to hang up a conference. 

Procedure 

To hang up a conference: 

 
 

 

Choose the Hangup button for the associated call appearance. 

The conference is disconnected. 
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Configure Your Audio Settings 

Introduction 

Using the Audio Tuning Wizard, you can: 

• select the recording device you want to use with Avaya iClarity IP Audio 

• select the playback device you want to use with Avaya iClarity IP Audio 

• specify whether you are using a headset/handset or PC speakers and a microphone 

• verify that your speakers or headset are operating properly 

• adjust the volume of your speakers or headset 

• verify that your microphone is operating properly 

• adjust the volume of your microphone 

• determine the level of the background noise at your location 

Keep in mind the following: 

• You will be unable to configure the audio settings while you are active on a call. 

• You must close all PC applications that record or play sound before configuring the 
audio settings. 

Procedure 

To configure your audio settings: 

  

1 
Close all applications that record or play sound. 

 

2 

Click the Audio Tuning Wizard button. 

The Audio Tuning Wizard dialog box appears. This dialog box enables you to select the 
devices you want to use to record and play back sound during your calls. 

 

3 
From the Select a recording device box, select the device you want to use to record sound 
on your PC during calls. 

 

4 
From the Select a playback device box, select the device you want to use to play sound on 
your PC during calls. 
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5 

Click the Next button. 

The second Audio Tuning Wizard dialog box appears. This dialog box enables you to specify 
whether you are using a headset/handset or PC speakers and a microphone to speak to and 
hear the other party on a call. The following options are available: 

• Headset or Handset 

Select this option button if you are using a headphone or a handset to speak to and 
hear the other party on a call. This option button is disabled if the Audio Tuning 
Wizard identified a half-duplex sound card in your PC. 

• PC Microphone and PC Speakers 

Select this option button if you are using a microphone and PC speakers to speak to 
and hear the other party on a call. 

• Half-Duplex Sound Device 

Select this option button if you have a half-duplex sound card in your PC. This 
option button is disabled if the Audio Tuning Wizard identified a full-duplex sound 
card in your PC. 

 

6 

Select the appropriate button, and then click the Next button. 

The third Audio Tuning Wizard dialog box appears. This dialog box enables you to verify that 
your PC speakers or headphone are operating properly and to adjust the volume of the 
speakers or headset. 

 

7 

Click the Test button. 

If your speakers or headset are operating properly, you will hear a sample sound file. Go to 
Step 8. 

If you do not hear the sample sound file, verify the connections between your PC and the 
speakers/headset and verify that your speakers are turned on. For more information, see the 
Sound Troubleshooter topic in Windows Help. 

 

8 
Move the slider to set the volume for the speakers/headset. Moving the slider to the right 
increases the volume. 

 

9 
When finished setting the volume, click the Stop button to stop the file from being played. 
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10 

Click the Next button. 

The fourth Audio Tuning Wizard dialog box appears. You will use this dialog box to verify 
that your microphone is operating properly and to adjust the recording level (that is, volume) 
of the microphone. 

If your microphone is operating properly, you will see the status indicators fluctuate in the 
Audio meter when you speak. Go to Step 11. 

If you do not see the status indicators fluctuate in the Audio meter when you speak, verify 
the connection between your PC and microphone. For more information, see Windows Help. 

 

11 

Perform one of the following steps: 

• If you want Avaya iClarity IP Audio to adjust the recording level for the microphone, 
click the Automatically adjust microphone recording level option button and 
then speak into the microphone for at least 30 seconds. 

The status indicators in the Audio meter, which indicate the microphone signal input 
level, should remain between the ^ symbols on the Audio meter. If the status 
indicators exceed or do not appear between the ^ symbols on the Audio meter, 
move the slider to set the sensitivity of the microphone. Moving the slider to the right 
increases the sensitivity. 

• If you want to adjust the recording level for the microphone manually, click the Use 
the following microphone recording level option button, and move the slider to 
set the recording level for the microphone. Moving the slider to the right increases 
the recording level. 

 

12 

When finished setting the recording level, click the Next button. 

The fifth Audio Tuning Wizard dialog box appears. This dialog box enables the Audio Tuning 
Wizard to determine the level of background noise at your current location. This prevents 
Avaya iClarity IP Audio from transmitting the background noise at your location when you are 
not speaking during a call. 

 

13 
Make sure there is no excessive noise. 
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14 

Click the Test button and then do not speak. 

The Test button becomes disabled, you are prompted to remain quiet, and the Audio Tuning 
Wizard determines the background noise level at your current location. This test lasts for 
approximately 10 seconds. When the test is completed, the Test button becomes enabled. 

If there was excessive noise during the test, repeat Steps 13 and 14. 

 

15 

When finished, click the Next button. 

A dialog box appears, informing you that you are finished configuring the audio settings. 

 

16 
Click the Finish button. 
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Mute Your Microphone 

Introduction 

If you are using Avaya iClarity IP Audio, you can mute the volume of the microphone from the 
Avaya IP Softphone window. 

Procedure 

To mute the microphone: 

 
 

1 
Make sure the microphone is on. 

 

2 

Click the Microphone control button on the Audio Control toolbar. 

The microphone is muted. 

To turn off the Mute feature, click the Microphone control button again. 
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Adjust the Microphone Volume 

Introduction 

If you are using Avaya iClarity IP Audio, you can adjust the volume of the microphone (that is, 
headset or internal/external microphone) from the Avaya IP Softphone window. 

Procedure 

To adjust the volume: 

 
 

1 
Make sure the microphone is on. 

 

2 

Click the Microphone Control arrow button on the Audio Control toolbar. 

The Volume control appears. 

 

3 
Move the slider to adjust the volume. 

 

 



 91 

Mute the Speakers 

Introduction 

If you are using Avaya iClarity IP Audio, you can mute the speakers (that is, headset or 
internal/external speakers) from the Avaya IP Softphone window. 

NOTE: 
When you mute the speakers, the ringer is muted automatically. 

Procedure 

To mute the speakers: 

 
 

1 
Make sure the speakers are on. 

 

2 

Click the Speaker Control button on the Audio Control toolbar. 

The speakers are muted. 

To turn off the Mute feature, click the Speaker control button again. 
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Adjust the Speaker Volume 

Introduction 

If you are using Avaya iClarity IP Audio, you can adjust the volume of the speakers (that is, 
headset or internal/external speakers) from the Avaya IP Softphone window. 

Procedure 

To adjust the volume: 

 
 

1 
Make sure the speakers are on. 

 

2 

Click the Speaker Control arrow button on the Audio Control toolbar. 

The Volume control appears. 

 

3 
Move the slider to adjust the volume. 
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Mute the Ringer 

Introduction 

You can mute the ringer for incoming calls in both the Road Warrior configuration and the 
Telecommuter configuration. 

NOTE: 
If you are using Avaya IP Softphone in the Road Warrior configuration, the ringer is muted 
automatically when you mute the speakers. 

Procedure 

To mute the ringer: 

Click the Ringer Control button  on the Audio Control toolbar. 

The ringer is muted. 

To turn off the Mute feature, click the Ringer Control button  again. 
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Adjust the Ringer Volume 

Introduction 

You can adjust the ringer volume for incoming calls in both the Road Warrior configuration 
and the Telecommuter configuration. 

NOTE: 
If you are using Avaya IP Softphone in the Road Warrior configuration, the ringer is muted 
automatically when you mute the speakers. 

Procedure 

To adjust the ringer volume: 

 
 

1 

Click the Ringer Control arrow button on the Audio Control toolbar. 

The Volume control appears. 

 

2 
Move the slider to adjust the volume. 
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Play Ringing through the Internal PC Speaker 

Introduction 

This procedure describes set Avaya iClarity IP Audio to play ringing through the internal 
speaker of the PC. 

Procedure 

To play ringing through the internal speaker of the PC: 

 
 

1 

From the Audio menu, select Volume and Ringer Settings. 

The Volume and Ringer Settings dialog box appears. 

 

2 
In the Ringer area, click the Also play ringing through the internal PC speaker check box. 

 

3 
Click the Close button. 
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Hear Your Voice in Your Headset when You Speak 

Introduction 

This procedure describes how to configure Avaya iClarity IP Audio so you can hear your 
voice in your headset when you speak. 

Procedure 

To hear your voice in your headset when you speak: 

 
 

1 

From the Audio menu, select Volume and Ringer Settings. 

The Volume and Ringer Settings dialog box appears. 

 

2 
Click the Hear my voice in the headset check box. 

 

3 
Click the Close button. 
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Using the Phone Directory 

Introduction 

You can store names, addresses, email addresses, notes, and phone numbers in the Phone 
Directory. The directory will support multiple numbers for each entry. 

The directory entries can be displayed with the following views: large icons, small icons, list, 
and detailed. In the detailed view, the entry's name, number, email, category, and notes are 
listed. The number displayed in this view is the first number found for the entry if multiple 
numbers are entered. The directory entries can be sorted by name, number, or category. 

Adding an entry to the Phone Directory 

The Phone Directory Properties dialog box enables you to add a new entry to the phone 
directory. You can add or edit directory entries using the Properties dialog box. To display the 
Properties dialog box, follow the steps below. 

 
 

1 

In the Avaya IP Softphone Call Bar window, click the Phone Directory button. 

The Phone Directory window appears. 

 

2 

Click the New entry button. 

The Properties dialog box appears. 

 

3 
In the Name box, enter the person's name. 

 

4 
In the Address box, enter the person's address. 

 

5 
In the Email box, enter the person's email address. 

 

6 
In the Notes box, enter any information you want. 
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7 

From the Category box, select the category to which you want to assign this entry. 

You can add, rename, or remove a category by clicking the “...” button on the Category box. 

To add a category: 

1. Click the “...” button next to the Category box. 

The Categories dialog box appears. 

2. In the text box, enter the category you want to add, and then click the Add button. 

3. Repeat Step 2 to create additional categories. 

4. When finished adding categories, click the Close button. 

 

8 

In the telephone number boxes (that is, Business, Home, and Pager), enter the person's 
phone numbers. 

The default labels of the telephone number boxes are Business, Home, and Pager. 
However, you can change these labels by clicking the “...” button next to telephone number 
box. Your choices are Business Fax, Home Fax, Mobile, Assistant, Car, and Company. 

If you want to assign a telephone number to a Speed Dial, perform the following steps: 

1. Click the Speed Dial check box for the telephone number you want to assign to a 
Speed Dial. 

The Speed Dial Function Keys dialog box appears. 

2. Perform one of the following steps: 

• If you want to assign this Speed Dial to a function key on your keyboard, click 
the Assign this number to a function key option button. (This number will 
also be added to the Speed Dial list.) 

• If you do not want to assign this Speed Dial to a function key, click the Add this 
number to the speed dial list option button. 

3. Click the OK button. 

4. Repeat Steps 1 through 3 if you want to create additional Speed Dials for this entry. 

 

9 
If you want the telephone numbers for this entry to be dialed as touch-tones during all calls, 
click the Dial number on current call check box. 

 

10 

When finished, click the OK button. 

The Phone Directory window displays the new entry. 
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Editing an entry in the Phone Directory 

The Phone Directory Properties dialog box enables you to edit directory entries. 

 
 

1 

In the Avaya IP Softphone Call Bar window, click the Phone Directory button. 

The Phone Directory window appears. 

 

2 

Select the entry you want to modify, and then click the Properties button. 

The Properties dialog box appears, displaying the information for the selected entry. 

 

3 
Make your changes. 

 

4 
When finished, click the OK button. 
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Setting the Fields Displayed in the Phone Directory Window 

You can specify which fields you want displayed in the Phone Directory window and the order 
in which those fields are displayed. 

To set the fields displayed in the Phone Directory window: 

 
 

1 

In the Avaya IP Softphone Call Bar window, click the Phone Directory button. 

The Phone Directory window appears. 

 

2 

From the Edit menu, select Field Organizer. 

The Field Organizer dialog box appears. The Show fields in this order box shows the fields 
that are currently displayed in the Phone Directory window. The order in which these fields 
are displayed in the Show fields in this order box indicates the order in which these fields will 
be displayed in the Phone Directory window. 

The Available box shows the fields that are not displayed currently in the Phone Directory 
window. 

 

3 

Perform any of the following steps: 

• If you want additional fields to be displayed in the Phone Directory window, select the 

appropriate fields in the Available box, and then click . If you want all of the 

fields to be displayed, click . The selected fields appear in the Show fields in 
this order box. 

• If you want one or more fields to no longer be displayed in the Phone Directory 
window, select the appropriate fields in the Show fields in this order box, and then 

click . If you want all of fields (except Name) to no longer be displayed, click 

. 

• To change the order in which the fields are displayed in the Phone Directory window, 
select the appropriate field in the Show fields in this order box, and then click 

or . The top position in the Show fields in this order box 
corresponds to the left-most column in the Phone Directory window. 

 

4 
When you are finished, click the OK button. 
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Making a call from the Phone Directory 

To make a call from the Phone Directory: 

 
 

1 

In the Avaya IP Softphone Call Bar window, click the Phone Directory button. 

The Phone Directory window appears. 

 

2 

Double-click on the name in the directory list. 

If the name in the directory entry has only one telephone number, that telephone number is 
dialed. 

If the name in the directory entry has more than one telephone number, a popup menu with a 
list of numbers appears. Select the appropriate number from the popup menu. The telephone 
number is dialed. 
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Import Files into the Phone Directory 

Introduction 

You can import the following files into a Phone Directory: 

• files saved in the comma-separated values format (".csv") 

• Phonebook files from DEFINITY IP Softphone R1 

If you want to import a .csv file, that file must be in the following format and order: 

1. Name 

2. Address 

3. Email 

4. Business Number 

5. Business Fax Number 

6. Home Number 

7. Home Fax Number 

8. Mobile Number 

9. Assistant Number 

10. Car Number 

11. Company Number 

12. Pager Number 

NOTE: 
Any field that contains a comma (,) must be surrounded by quotes. 

Each record in the .csv file can contain a maximum of 12 fields. An error will occur if your 
imported .csv file has a record that contains more than 12 fields. Your .csv file may have 
records that contain less than 12 fields. 

Refer to the online help of the application from which you want to export data for information 
on how to save data in the .csv format. 
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Import a .csv File 

To import a .csv file into the Phone Directory: 

 
 

1 

Open the Phone Directory window. 

The Phone Directory window appears. 

 

2 

From the File menu in the Phone Directory window, select Import. 

A submenu appears. 

 

3 

Select Text file. 

The File open for import dialog box appears. 

 

4 
Select the file you want to import. 

 

5 

Click the OK button. 

The new data is imported into the Phone Directory. 
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Import a Phonebook file from IP Softphone R1 

When you import a Phonebook file from IP Softphone R1, the information from the 
Phonebook fields is placed into the following Phone Directory fields: 

• Last Name field = Name field 

• First Name/Initial field = Name field 

• Business Phone # field = Business field 

• Business Fax # field = Business Fax field 

• Home Phone # field = Home field 

• Alternate Phone # field = Mobile field 

• E-mail Address field = Email field 

• Mailing Address field = Address field 

NOTE: 

The information in the Notes field of Phonebook is not imported to the Phone Directory. 

To import a Phonebook file into the Phone Directory: 

 
 

1 

Open the Phone Directory window. 

The Phone Directory window appears. 

 

2 

From the File menu in the Phone Directory window, select Import. 

A submenu appears. 

 

3 

Select IP Softphone R1 Phonebook. 

The Open Phonebook file for Import dialog box appears. 

 

4 
Select the Phonebook file you want to import. The default location is c:\Program 
Files\Lucent\DEFINITY IP Softphone\Pbook.mdb. 

 

5 

Click the OK button. 

The Phonebook entries are imported into the Phone Directory. 
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Export Entries from the Phone Directory 

Introduction 

You can export all of the entries from the Phone Directory to a file in the comma-separated 
values format (".csv"), which can be used in other applications. During the export procedure, 
Phone Directory takes the fields (including the Notes field) for each directory entry and writes 
them out in a horizontal line in a .csv file. This line of information from a directory entry is 
referred to as a "record." For example, if you export a Phone Directory that has 300 entries, 
the .csv file will have 300 records. 

When you export a Phone Directory, the data is exported to the .csv file in the following 
format: 

• Name 

• Address 

• Email 

• Business Number 

• Business Fax Number 

• Home Number 

• Home Fax Number 

• Mobile Number 

• Assistant Number 

• Car Number 

• Company Number 

• Pager Number 
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Procedure 

To export the entries from the Phone Directory: 

 
 

1 

Open the Phone Directory window. 

The Phone Directory window appears. 

 

2 

From the File menu in the Phone Directory window, select Export. 

The Save Exported Database As dialog box appears. 

 

3 
Enter the path and name of the file to which the directory entries will be exported. 

 

4 

Click the Save button. 

The Phone Directory entries are exported to the file you specified. 
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Using the Call History Log 

Introduction 

The Call History log stores information on incoming and outgoing calls by automatically 
generating a call record or one-line summary of each call. You can add or modify notes in the 
record, delete the call record, or dial the selected number from the record. 

Procedures 

To use the Call History log: 

 
 

1 

On the Avaya IP Softphone menu bar, click the Call History button. 

The Call History log appears. 

 

2 

Perform any of the following steps: 

• To call a number from the Call History log, click the record containing the phone 
number you want to dial, and then click the Dial Number button. You may also call a 
number by simply double-clicking the icon preceding the call record. 

• To edit a record in the Call History log, highlight the record and select Edit from the 
menu bar. You can edit the Name, Number, and Notes fields. 

• To add a record from the Call History log to the Phone Directory, highlight the record 
and then click the Add to Directory button. 

• To delete a record from the Call History log, highlight the record and click the Delete 
button. 

• To sort call records by a specific category (for example, "Name"), click on the 
appropriate category heading. You can sort call records according to the following 
categories: Name, Number, Time, Date, and Duration. You cannot sort call records by 
the Notes category. 
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View the Call History Log 

Introduction 

The Call History log displays information about incoming and outgoing calls. The information 
stored includes the name of the person, the number dialed or the number received, date, 
time, and duration of the call. The log contains a menu bar, toolbar, status bar, and a call 
history record. 

For more information about the Call History log, including adding Call History numbers to the 
Phone Directory, see “Using the Call History Log.”  

The symbols on the Call History dialog box are as follows: 

Incoming call: 

 

Outgoing call: 

 

The Call History log contains the following fields: 

• Name field: Contains the name of the calling party, followed by the number type (for 
example, business, home, or fax). 

• Number field: Contains the phone number dialed for outgoing calls. For incoming 
calls, the number displayed depends on the features provided by the telephone 
system. If the telephone system provides caller identification information, that number 
will be displayed. 

• Date and Time fields: Contain the date and time the call originated. 

• Duration field: Displays the length of the call. 

• Notes field: Contains optional information entered by the user. This field supports 255 
characters. 
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Accessing a Voice Messaging System 

Introduction 

Avaya IP Softphone notifies you when you receive a voice mail message and enables you to 
access your voice messaging system from Avaya IP Softphone. When you receive a voice 
mail message, the Message Waiting Indicator on your telephone is turned "on." When this 
occurs, Avaya IP Softphone displays the Voice Messages icon in the system tray, indicating 
that you have voice mail. You can access your voice messaging system from Avaya IP 
Softphone by clicking on the Voice Messages icon. However, you must first configure Avaya 
IP Softphone to access your voice messaging system. If you click on the Voice Messages 
icon before configuring Avaya IP Softphone to access your voice messaging system, no 
action occurs (that is, Avaya IP Softphone does not access your voice messaging system). 

You can set Avaya IP Softphone to access your voice messaging system in one of the 
following ways: 

• dial the access number of the voice messaging system 

• open an application (such as Intuity Message Manager) that accesses the voice 
messaging system 

• open a web browser and go to the web page for the voice messaging system (such 
as Avaya's web access based visual interface application, www.messenger, which is 
part of Avaya's Visual Desktop Messaging Suite) 

Voice Messaging Access includes the following topics: 

• Configure IP Softphone to access a Voice Messaging System 

• Access the Voice Messaging System 
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Configure Avaya IP Softphone to Access  
a Voice Messaging System 

Introduction 

When you receive a voice mail message, the Message Waiting Indicator on your telephone is 
turned "on." When this occurs, Avaya IP Softphone displays the Voice Messages icon in the 
system tray and turns on the Voice Messages Status button in the main window and the 
Picture of Phone window, indicating that you have voice mail. You can access your voice 
messaging system from Avaya IP Softphone by clicking on the Voice Messages icon or the 
Voice Messages Status button. However, you must first configure Avaya IP Softphone to 
access your voice messaging system. If you click on the Voice Messages icon or Voice 
Messages Status button before configuring Avaya IP Softphone to access your voice 
messaging system, no action occurs (that is, Avaya IP Softphone does not access your voice 
messaging system). 

You can set Avaya IP Softphone to access your voice messaging system in one of the 
following ways: 

• dial the access number of the voice messaging system 

• open an application (such as Intuity Message Manager) that accesses the voice 
messaging system 

• open a web browser and go to the web page for the voice messaging system (such 
as Avaya's web access based visual interface application, www.messenger, which is 
part of Avaya's Visual Desktop Messaging Suite) 

Procedure 

To configure Avaya IP Softphone to access your voice messaging system: 

 
 

1 

From the Tools menu, select Program Options. 

The Program Options dialog box appears. 

 

2 

Click Voice Messaging Access in the list box. 

The Voice Messaging Access information appears. 

 

3 

Click the Enable Voice Messaging Access check box. 

A check mark appears in the Enable Voice Messaging Access check box, indicating that 
this feature is enabled. 

NOTE: 
If you do not want Avaya IP Softphone to access the voice messaging system, make sure the 
Enable Voice Messaging Access check box is not selected, and then go to Step 5. 
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4 

Perform one of the following steps: 

• If you want Avaya IP Softphone to dial a telephone number: 

1. Click the Dial this number option button. 

2. In the text box, enter the telephone number you want to dial to access the 
voice messaging system. 

3. Go to Step 5. 

• If you want Avaya IP Softphone to open another application (such as Intuity Message 
Manager) to access the voice messaging system: 

1. Click the Open this application option button. 

2. Using the Browse button, select the application you want to run. 

The path and file name for the selected application appears. 

3. Click the Test button to verify that the application you selected opens 
properly. 

4. Go to Step 5. 

• If you want Avaya IP Softphone to open a web browser to access the web page for 
the voice messaging system (such as Avaya's www.messenger): 

1. Click the Go to the web page option button. 

2. In the text box, enter the web page for the voice messaging system. 

3. Click the Test button to verify that the web browser opens properly and 
displays the web page you specified. 

4. Go to Step 5. 

 

5 
Click the OK button. 
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Access the Voice Messaging System 

Introduction 

When you receive a voice mail message, the Message Waiting Indicator on your telephone is 
turned "on." When this occurs, Avaya IP Softphone displays the Voice Messages icon in the 
system tray and turns on the Voice Messages Status button in the main window and the 
Picture of Phone window, indicating that you have voice mail. You can access your voice 
messaging system from Avaya IP Softphone by clicking on the Voice Messages icon or the 
Voice Messages Status button. However, you must first configure Avaya IP Softphone to 
access your voice messaging system. If you click on the Voice Messages icon or Voice 
Messages Status button before configuring Avaya IP Softphone to access your voice 
messaging system, no action occurs (that is, Avaya IP Softphone does not access your voice 
messaging system). 

Procedure 

To access your voice messaging system: 

 
 

 

Perform one of the following steps: 

• Click the Voice Messages icon in the system tray. 

• Click the Voice Messages Status button in the Avaya IP Softphone Call Bar window. 

• Click the Voice Messages Status button in the Picture of Phone window. 

Depending on how you configured the Voice Messaging Access feature, Avaya IP Softphone 
attempts to contact your voice messaging system. 
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Using the Picture of Phone Window 

Introduction 

The Picture of Phone window provides a simulation of your telephone. From this window, you 
handle calls just as you would from your telephone. You can also change the labels of the 
feature buttons and softkeys displayed in the Picture of Phone window. 

Handle Calls 

To handle calls from the Picture of Phone window: 

 
 

1 

Perform one of the following steps: 

• Click the Picture of Phone button on the Dial Number toolbar in the Avaya IP 
Softphone Call Bar window. 

• Right-click on the Avaya IP Softphone icon in the system tray, and select Picture of 
Phone. 

The Picture of Phone window appears. 

 

2 
Using the buttons in the Picture of Phone window, handle calls the same way as you would 
from your telephone. 
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Change the Feature Button Labels 

To change the labels of the feature buttons displayed in the Picture of Phone window: 

 
 

1 

Perform one of the following steps: 

• Click the Picture of Phone button on the Dial Number toolbar in the Avaya IP 
Softphone Call Bar window. 

• Right-click on the Avaya IP Softphone icon in the system tray, and select Picture of 
Phone. 

The Picture of Phone window appears. 

 

2 
Click . 

The labels you can modify are highlighted. 

 

3 
Click on the label you want to change, and make your changes. 

 

4 
Repeat Step 3 for any other labels you want to change. 

 

5 When you are finished, click . 
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Change the Softkey Labels 

To change the labels of the softkeys displayed in the Picture of Phone window: 

 
 

1 

Perform one of the following steps: 

• Click the Picture of Phone button on the Dial Number toolbar in the Avaya IP 
Softphone Call Bar window. 

• Right-click on the Avaya IP Softphone icon in the system tray, and select Picture of 
Phone. 

The Picture of Phone window appears. 

 

2 

Click Menu button. 

The softkey labels are displayed. 

 

3 
Click . 

The labels you can modify are highlighted. 

 

4 
Click on the label you want to change, and make your changes. 

 

5 
Repeat Step 4 for any other labels you want to change. 

 

6 When you are finished, click . 

 

 



 116 

Searching Public Directories 

Introduction 

The Search Public Directory feature enables you to access corporate or public directory 
services. Using this feature, you can query and manage an LDAP (Lightweight Directory 
Access Protocol) database (such as a directory) over a TCP/IP connection. At installation, 
Avaya IP Softphone is preconfigured to allow you to access the Bigfoot and WhoWhere 
public directories immediately. You can configure Avaya IP Softphone to access additional 
public directories. 

From the Search Public Directory window, you can 

• place calls to entries in the public directory 

• copy entries to your Phone Directory 

• send email to entries in the public directory 

Search a Public Directory 

To search a public directory: 

  

1 

Perform one of the following steps: 

• Click the Search Public Directory button  in the Avaya IP Softphone Call Bar 
window. 

• Select Search Public Directory from the Tools menu in the Avaya IP Softphone Call 
Bar window. 

• Right-click on the Avaya IP Softphone icon in the system tray, and select Search 
Public Directory. 

The Search Public Directory window appears. 

 

2 Click the Directory Menu button , and select the directory you want to search. 

 

3 

Click the Search by button, and select the type of information for which you want to search. 
Your choices are Name, Number, and/or Email. 

The type of data you selected appears as the label for the text box at the top of the window. 
For example, if you selected Number, the text box label changes from Name to Number. 

 

4 
In the search text box, enter the information you want to find. 
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5 

Click the Search button. 

The name, phone number, email, organization, and city (if available) is displayed for each 
entry that matches your search criteria. 

 

6 

At this point, you can: 

• Dial the associated telephone number for the selected entry by clicking the Dial 
Number button. 

• Copy the information for the selected entry and save it as an entry in the Avaya IP 
Softphone Phone Directory by clicking the Add to Directory button. 

When an entry is added to the Avaya IP Softphone Phone Directory, the information 
in the name, phone, and email fields are entered automatically. 

• Create an email message that you can send to the email address (if available) for the 
selected entry by clicking the Send Email button. (This action launches your email 
application and inserts the email address of the selected entry into the To: field of a 
new message.) 

 

 



 118 

Set the Fields Displayed in the Phone Directory Window 

You can specify which fields you want displayed in the Phone Directory window and the order 
in which those fields are displayed. 

To set the fields displayed in the Phone Directory window: 

 
 

1 

In the Avaya IP Softphone Call Bar window, click the Phone Directory button. 

The Phone Directory window appears. 

 

2 

From the Edit menu, select Field Organizer. 

The Field Organizer dialog box appears. The Show fields in this order box shows the fields 
that are currently displayed in the Phone Directory window. The order in which these fields 
are displayed in the Show fields in this order box indicates the order in which these fields will 
be displayed in the Phone Directory window. 

The Available box shows the fields that are not displayed currently in the Phone Directory 
window. 

 

3 

Perform any of the following steps: 

• If you want additional fields to be displayed in the Phone Directory window, select the 

appropriate fields in the Available box, and then click . If you want all of the 

fields to be displayed, click . The selected fields appear in the Show fields in 
this order box. 

• If you want one or more fields to no longer be displayed in the Phone Directory 
window, select the appropriate fields in the Show fields in this order box, and then 

click . If you want all of fields (except Name) to no longer be displayed, click 

. 

• To change the order in which the fields are displayed in the Phone Directory window, 
select the appropriate field in the Show fields in this order box, and then click 

or . The top position in the Show fields in this order box 
corresponds to the left-most column in the Phone Directory window. 

 

4 
When you are finished, click the OK button. 
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Set up Access to a Public Directory 

At installation, Avaya IP Softphone is preconfigured to allow you to access the Bigfoot and 
WhoWhere public directories immediately. However, you can configure Avaya IP Softphone 
to access additional public directories. Before you can access an additional a public directory, 
you must create an account the for the public directory in the Search Public Directory 
window. To access a public directory, you must know the server address for the LDAP client. 
However, depending on the directory you want to access, you may also need to know the 
following information: 

• search root for the LDAP client 

• login 

• password 

To set up access to a public directory: 

  

1 

Perform one of the following steps: 

• Click the Search Public Directory button  in the Avaya IP Softphone Call 
Bar window. 

• Select Search Public Directory from the Tools menu in the Avaya IP Softphone 
Call Bar window. 

• Right-click on the Avaya IP Softphone icon in the system tray, and select Search 
Public Directory. 

The Search Public Directory window appears. 

 

2 
Click the Directory Menu button , and select Add. 

The Directory Properties dialog box appears. 

 

3 

In the General tab, enter the following information about the specified directory: 

• Description 

• Server address 

• Login 

• Password 

• Search Root 

Important! 

Login and password requirements depend on the database you are accessing. 
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4 

Click the Advanced tab. 

The Advanced tab appears. 

 

5 

In the Advanced tab, enter or edit the following: 

• Port 

• Search Timeout 

• Max. Entries Returned 

Important! 

These settings are determined by the administrators of the database you are accessing. 

 

6 

When you are finished, click the OK button. 

The directory has now been added. To make this new directory the "active" public 
directory (that is, the directory you want to search), you must select it. (See "Search a 
Public Directory.") 
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Modify Access to a Public Directory 

To modify access to a public directory: 

 
 

1 

Perform one of the following steps: 

• Click the Search Public Directory button  in the Avaya IP Softphone Call Bar 
window. 

• Select Search Public Directory from the Tools menu in the Avaya IP Softphone Call 
Bar window. 

• Right-click on the Avaya IP Softphone icon in the system tray, and select Search 
Public Directory. 

The Search Public Directory windows appears. 

 

2 
Click the Directory Menu button , and select the directory you want to modify. 

The name of the selected directory appears next to the Directory Menu button. 

 

3 
Click the Directory Menu button , and select Properties. 

The Directory Properties dialog box appears, displaying the settings for the selected directory. 

 

4 
Make your changes. 

 

5 
When you are finished, click the OK button. 

 

 



 122 

Remove Access to a Public Directory 

To remove access to a public directory: 

 
 

1 

Perform one of the following steps: 

• Click the Search Public Directory button in the Avaya IP Softphone Call Bar 
window. 

• Select Search Public Directory from the Tools menu in the Avaya IP Softphone Call 
Bar window. 

• Right-click on the Avaya IP Softphone icon in the system tray, and select Search 
Public Directory. 

The Search Public Directory windows appears. 

 

2 

Click the Directory Menu button , and select the directory for which you want to remove 
access. 

The name of the selected directory appears next to the Directory Menu button. 

 

3 
Click the Directory Menu button , and select Remove. 

Access to the selected directory is removed. 
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Configuring Screen Pops 

Introduction 

Screen pops are used to trigger application actions. You can create the following two types of 
screen pops: 

• a screen pop that uses a web page (URL), a Windows application, or a file. 

• a screen pop that uses a DDE server. 

Create a Screen Pop that uses a Web Page, an Application, or a File 

To create a screen pop that uses a web page, an application, or a file: 

1. From the Tools menu, select Screen Pops. 

The Screen Pops window appears. 

2. From the File menu, select New. 

The Screen Pops dialog box appears. 

3. In the text box, enter a name for the screen pop you want to create. 

4. Click the Open an application, a file, or a web page option button. 

5. Click the Next button. 

The Trigger dialog box appears. 

6. Perform one of the following steps: 

• If you want this screen pop to run when you receive a call, select the 
appropriate option button in the Incoming Call area. 

• If you want this screen pop to run when you make a call, select the 
appropriate option button in the Outgoing Call area. 

7. Click the Next button. 

The Action dialog box appears. 

8. Perform one of the following steps: 

• If you want this screen pop to access a URL, click the Enter a web page 
address (URL) option button, and enter the address of the URL you want to 
access. 

• If you want this screen pop to run an application or a file, click the Enter an 
application or file path option button, and use the Browse button to select 
the application or file you want to use. 

9. Click the arrow button next to the text box, and select the call information you want the 
screen pop to use. 

10. Click the Next button. 

If the screen pop will use Start Time or Date, the Testing dialog box appears. Go to 
Step 12. 

If the screen pop will not use Start Time or Date, the Format Call Information dialog 
box appears. Go to Step 11. 
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11. Perform one of the following steps: 

• If you want the screen pop to send part of the call information you specified: 

1. Click the Send Part check box. 

2. From the Number of characters to include box, select the number of 
characters you want send. 

3. From the Location box, select the location of the characters you want 
to send. 

4. Click the Next button. 

• If you do not want the screen pop to send part of the call information you 
specified, click the Next button. 

The Testing dialog box appears. Using this dialog box, you can verify whether your 
screen pop will properly access the URL you specified or run the application you 
specified. 

12. Click the Test button. 

If the screen pop will use Start Time or Date, Avaya IP Softphone performs the screen 
pop. Go to Step 15. 

If the screen pop will not use Start Time or Date, the Enter the following data dialog 
box appears. Go to Step 13. 

13. Enter the appropriate call information to test the screen pop. (For example, if the 
screen pop will use Caller Name, enter a caller name that exists in the application, file, 
or web page the screen pop is using.) 

14. Click the Continue button. 

The screen pop uses the information you entered. 

15. Perform one of the following steps: 

• If the screen pop worked properly, click the Next button and go to the next step. 

• If the screen pop did not work properly, click the Back button and verify the 
information you entered. 

16. Click the Finish button. 

The screen pop you created appears in the Screen Pops window. Avaya IP Softphone 
will not use this screen pop until you activate it. You activate a screen pop by clicking 
on its check box. (A check mark indicates that the screen pop is active.) 
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Create a DDE Screen Pop 

To create a DDE screen pop: 

1. From the Tools menu, select Screen Pops. 

The Screen Pops window appears. 

2. From the File menu, select New. 

The Screen Pops dialog box appears. 

3. In the text box, enter a name for the screen pop you want to create. 

4. Select the Dynamic Data Exchange (DDE) option button. 

5. Click the Next button. 

The Trigger dialog box appears. 

6. Perform one of the following steps: 

• If you want this screen pop to run when you receive a call, select the 
appropriate option button in the Incoming Call area. 

• If you want this screen pop to run when you make a call, select the 
appropriate option button in the Outgoing Call area. 

7. Click the Next button. 

The Action dialog box appears. 

8. In the Service box, enter a string expression identifying an application that can 
participate in a DDE conversation. Usually, the application argument is the name of an 
executable file (without the .exe extension) for a Windows-based application. 

9. In the Topic box, enter a string expression that is the name of a topic recognized by 
the application argument. This will be the second parameter of the DDEInitiate() 
function. 

10. Perform one of the following steps: 

• If you want this screen pop to send information using the "execute" command: 

1. Click the Execute Command option button. 

2. In the text box, enter the a string expression specifying a command 
recognized by the server application. This string will only be changed 
to input caller information. The syntax must match the syntax required 
by the DDE program. For example, if embedded quotes must be 
quoted (for example, "name = ""Lang"""), then the string must be 
entered that way. 

3. Click the arrow button next to the text box, and select the call 
information you want the screen pop to use. 

• If you want this screen pop to send information using the "poke" command: 

1. Click the Poke Item option button. 

2. In the text box, enter a string expression that is the name of a date 
item recognized by the topic specified by the DDEInitiate function. 

3. In the Data box, enter a string containing the data to be supplied to 
the other application. 

4. Click the arrow button next to the Data box, and select the call 
information you want the screen pop to use. 
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11. Click the Next button. 

If the screen pop will use Start Time or Date, the Testing dialog box appears. Go to 
Step 13. 

If the screen pop will not use Start Time or Date, the Format Call Information dialog 
box appears. Go to Step 12. 

12. Perform one of the following steps: 

• If you want the screen pop to send part of the call information you specified: 

1. Click the Send Part check box. 

2. From the Number of characters to include box, select the number 
of characters you want to send. 

3. From the Location box, select the location of the characters you want 
to send. 

4. Click the Next button. 

• If you do not want the screen pop to send part of the call information you 
specified, click the Next button. 

The Testing dialog box appears. Using this dialog box, you can verify whether your 
screen pop will work properly 

13. Click the Test button. 

If the screen pop will use Start Time or Date, Avaya IP Softphone performs the screen 
pop. Go to Step 16. 

If the screen pop will not use Start Time or Date, the Enter the following data dialog 
box appears. Go to Step 14. 

14. Enter the appropriate call information to test the screen pop. (For example, if the 
screen pop will use Caller Name, enter a caller name that exists in the DDE server the 
screen pop is using.) 

15. Click the Continue button. 

The screen pop uses the information you entered. 

16. Perform one of the following steps: 

• If the screen pop worked properly, click the Next button and go to the next 
step. 

• If the screen pop did not work properly, click the Back button and verify the 
information you entered. 

17. Click the Finish button. 

The screen pop you created appears in the Screen Pops window. Avaya IP Softphone will not 
use this screen pop until you activate it. You activate a screen pop by clicking on its check 
box. (A check mark indicates that the screen pop is active.) 
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Modify a Screen Pop 

To modify a screen pop: 

1. From the Tools menu, select Screen Pops. 

The Screen Pops window appears, displaying the screen pops you have created. 

2. Select the screen pop you want to modify. 

3. Click the Properties button. 

The Properties dialog box appears, displaying the properties of the selected screen 
pop. 

4. Make your changes to the screen pop. 

5. When finished, click the OK button. 

6. Close the Screen Pops window. 

Activate a Screen Pop 

Once you create a screen pop, you must activate it when you want to use it. To activate a 
screen pop: 

1. From the Tools menu, select Screen Pops. 

The Screen Pops window appears, displaying the screen pops you have created. 

2. Click the check box for the screen pop you want to activate. 

A check mark indicates that the screen pop is activated. 

Delete a Screen Pop 

To delete a screen pop: 

1. From the Tools menu, select Screen Pops. 

The Screen Pops window appears, displaying the screen pops you have created. 

2. Select the screen pop you want to delete. 

3. Click the Delete button. 

The selected screen pop is deleted. 
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Sample Screen Pop that uses a Web Page 

The following procedure describes how to create a non-DDE screen pop that uses the caller 
number of the incoming call and searches for the matching number in your company's 
directory web page. Before performing this procedure, make sure you can access your 
company's directory web page. 

To create a screen pop for a web page: 

1. From the Tools menu, select Screen Pops. 

The Screen Pops window appears. 

2. From the File menu, select New. 

The Screen Pops dialog box appears. 

3. In the text box, enter Incoming Web Page. 

4. Click the Open an application, a file, or a web page option button. 

5. Click the Next button. 

The Trigger dialog box appears. 

6. Select the Ringing option button in the Incoming Call area. 

7. Click the Next button. 

The Action dialog box appears. 

8. Click the Enter a web page address (URL) option button, and enter the full address 
that appears in your web browser when you access the web page for searching your 
company's directory (for example, http://post.avaya.com/cgi-bin/htpq?tel=). 

9. Click the arrow button next to the text box. 

A menu appears. 

10. Select Caller Number (%m), and click the Next button. 

The Format Call Information dialog box appears. 

11. Click the Next button. 

The Testing dialog box appears. 

12. Click the Test button. 

The Enter the following data dialog box appears. 

13. In the Caller Number (%m) box, enter a telephone number that appears in your 
company's directory (for example, your telephone number). 

14. Click the Continue button. 

Your web browser starts and displays the directory record that matches the telephone 
number you entered. 

15. Click the Next button. 

The Setup Completed dialog box appears. 

16. Click the Finish button to save this screen pop. 

The new screen pop appears in the Screen Pops windows. 

17. Click the check box for this screen pop to activate it. 
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Administering Dialing Properties 

Introduction 

The Dialing Properties window determines when and how numbers are formatted and dialed. 

To administer dialing properties: 

1. From the Settings menu, select Dialing Properties. The Dialing Properties window 
appears. 

2. In the Dialing Properties window (see example below), enter the information asked for 
in the fields. Refer to Microsoft Windows Help for information on what to enter in the 
Dialing Properties window. 

Tip: Remember that these are the dialing properties for the switch you are connected 
to, not your home phone. 

These are the minimum fields that you need to fill in: 

• Country/region area code (Some countries will need to set area code rules.) 

• For local calls, dial 

• For long distance calls, dial (usually the same number as the local access 
number.) 

When you dial a number from Avaya IP Softphone, the number will be formatted based on the 
information configured on the computer in the Dialing Properties dialog box. 

For example, if your configuration is as follows: 

• Area Code: 303. 

• To access an outside line for local calls, dial 9. 

• To access an outside line for long-distance call, dial 9. 

The following table shows how numbers are formatted and dialed: 

User Enters Formatted Number Number Dialed 

5551212 +1 (303) 555-1212 9 555-1212 

85571 85571 85571 

8005551212 +1 (800) 555-1212 9 1 800 555-1212 

61295551212 +6 (129) 555-1212 9 011 6 129 555-1212 

800flowers +1 (800) FLOWERS 9 1 800 356-9377 

95551212 95551212 95551212 

918005551212 918005551212 918005551212 
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Configuring Avaya IP Softphone Options 

Introduction 

You can configure the following settings in Avaya IP Softphone: 

• General Settings 

whether you want Avaya IP Softphone to handle voice call requests from other 
programs. When this check box is enabled, Avaya IP Softphone becomes the default 
application to perform TAPI-assisted dialing for other applications. 

• Call Handling 

whether you want the Transfer button on the Phone Buttons toolbar to perform a 
supervised transfer or an unsupervised transfer. 

• Call History 

o whether you want to log incoming calls 

o whether you want to log outgoing calls 

o the number of months you want to keep the call records in the Call History 
Log 

o the number of recent calls you want displayed 

o the ability to clear all of the records in the Call History Log 

• Call Information Display 

o whether you want the call information to be displayed on the title bar of the 
Avaya IP Softphone window during a call 

o whether you want the call information to be replaced with the associated 
Phone Directory entry 

o whether you want to use the Japanese font to display call information 

o the size of the font used to display call information in a call appearance 

• Database Location 

the location of the database (that is, agent.mdb) for the Phone Directory and Call 
History Log 

• User Interface Options 

o whether you want the Avaya IP Softphone main window (that is, the Call Bar 
window) always displayed on top of other application windows 

o whether you want tooltips displayed for the buttons on the Avaya IP 
Softphone toolbars 

o whether you want letters displayed for the buttons in the Dial Pad window 
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• Incoming Calls 

o whether you want the Avaya IP Softphone window (Call Bar window and/or 
Picture of Phone window) to appear (that is, the window will open if it is 
currently minimized on your desktop) when you receive a call 

o whether you want the title bar of the Avaya IP Softphone Call Bar window 
(and its associated icon) to flash the color you specified for the active desktop 
application when you receive a call. 

NOTE: 
Setting the Avaya IP Softphone window to flash when you receive incoming 
calls does not make the Avaya IP Softphone window the active window every 
time you receive a call. Even though the Avaya IP Softphone window flashes 
the color that you specified for the active desktop application when you 
receive a call, the Avaya IP Softphone window will not necessarily be the 
active window. For example, if you set the Avaya IP Softphone window to 
flash on incoming calls, and you receive a call while you are viewing a web 
page in your web browser, your web browser continues to be the active 
application. 

• Number Format 

o the maximum number of digits in the city code 

o the minimum number of digits (including the city code) in external telephone 
numbers 

o the maximum number of digits (including the city code) in external telephone 
numbers 

o whether you want to dial seven-digit internal telephone numbers 

• Event Logging 

o the event logs you want Avaya IP Softphone to maintain 

o the ability to view the event logs 

o the ability to monitor the event logs 

o whether your system supports seven-digit internal telephone numbers 

• Voice Messaging Access 

whether you want Avaya IP Softphone to access your voice messaging system. If you 
enable voice messaging access, you must configure Avaya IP Softphone to access 
your voice messaging system. 

• Feature Access 

the ability to set user restrictions on the Program Options feature, the Phone 
Directory, the Call History Log, the Search Public Directory feature, phone features, 
and screen pops. 

• Language 

the ability to select the language you want Avaya IP Softphone to use. 

NOTE: 
Do not use the High Contrast Black color scheme for your active windows. 



 132 

Setting Options 

To set the Avaya IP Softphone options: 

 
 

1 

From the Avaya IP Softphone Call Bar window, select Program Options from the Tools 
menu. 

The Program Options dialog box appears. 

 

2 

In the list box, click on the setting you want to administer. 

The associated options are displayed. 

 

3 
Make your changes. 

 

4 
Repeat Steps 2 and 3. 

 

5 
When finished, click the OK button to activate the options. 
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Exporting the Settings 

To export these settings to a disk or shared network directory: 

 
 

1 

From the Avaya IP Softphone Call Bar window, select Export Settings from the File menu. 

The Save As dialog box appears. 

 

2 

In the Save As dialog box, enter the following fields (or accept the defaults): 

• Save in—navigate to the drive and folder where you want to save the file. 

• File name—enter the name of the file. 

• Save as type—select the type of file. 

 

3 
Click Open as read-only if you do not want users updating the file. 

 

4 

Select Save to save the file to the destination folder you specified. 

The user can now import the configuration information from the appropriate location. 
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Importing the Settings 

You can now import the configuration information from a disk or shared network directory to 
your computer. To import the settings: 

 
 

1 

From the Avaya IP Softphone Call Bar window, select Import Settings from the File menu. 

The Open dialog box appears. 

 

2 

In the Open dialog box, select the file you want to import, and then click the Open button. 

Avaya IP Softphone informs you that the configuration information has been successfully 
entered into the registry. 

 

3 

Click the OK button or press the ENTER key. 

The options your supervisor has set up for your station have been successfully imported. 

 

Selecting the Language for Avaya IP Softphone 

To select the language: 

 
 

1 

From the Avaya IP Softphone Call Bar window, select Language from the Settings menu. 

The Select a Language dialog box appears. 

 

2 

Select the language you want Avaya IP Softphone to use, and then click the OK button. 

NOTE: 
The language you select will not be used until you exit and restart Avaya IP Softphone. 
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Setting Avaya IP Softphone to Dial Seven-Digit Numbers as Internal Telephone Numbers 

To configure Avaya IP Softphone to dial seven-digit numbers as internal telephone numbers: 

 
 

1 

From the Avaya IP Softphone Call Bar window, select Program Options from the Tools 
menu. 

The Program Options dialog box appears. 

 

2 

Click on Number Format. 

The Number Format information appears. 

 

3 
Select the Enable 7 digit dial plan for internal calls check box. 

 

4 

Click the OK button. 

NOTE: 
The new setting will not be used until you exit and restart Avaya IP Softphone. 
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Setting a Password for the Feature Access Settings 

To configure a password for the Feature Access settings: 

 
 

1 

From the Avaya IP Softphone Call Bar window, select Program Options from the Tools 
menu. 

The Program Options dialog box appears. 

 

2 

Click on Feature Access. 

The Feature Access information appears. 

 

3 

Click the Set Password button. 

The Change Password dialog box appears. 

 

4 
In the New password box, enter your new password. 

 

5 
In the Confirm new password box, reenter your new password. 

 

6 
Click the OK button. 

 

7 

Click the OK button to close the Program Options dialog box. 

The next time you want to access the Feature Access settings, you must click the Enter 
Password button and enter your password. 
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To change or remove the password for the Feature Access settings: 

 
 

1 

From the Avaya IP Softphone Call Bar window, select Program Options from the Tools 
menu. 

The Program Options dialog box appears. 

 

2 

Click on Feature Access. 

The Feature Access information appears, but it is disabled. 

 

3 

Click the Enter Password button. 

The Enter Password dialog box appears. 

 

4 
Enter your password, and click the OK button. 

 

5 

Click the Change Password button. 

The Change Password dialog box appears. 

 

6 

Perform one of the following steps: 

• If you want to change your password: 

1. Enter your new password in the New password box. 

2. Reenter your new password in the Confirm new password box. 

3. Click the OK button. 

• If you want to remove the password from the Feature Access settings: 

1. Leave both boxes empty, and click the OK button. 

A dialog box appears, prompting you to confirm your action. 

2. Click the Yes button. 

 

7 
Click the OK button to close the Program Options dialog box. 
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Using the Phone Feature Options 

Introduction 

Avaya IP Softphone enables you to access the following windows to use and manage 
telephone feature buttons: 

• Phone Features window 

The Phone Features window displays in a "tree" view all of the feature buttons 
administered on the server for the physical station terminal of the extension you are 
logged into. 

• Personal Phone Features window 

The Personal Phone Features window enables you to create a personal list of the 
phone features you use most often by copying those features from the Phone 
Features window. You can select any feature button to add to your Personal Phone 
Features window. 

Using the Phone Features window 

To access the Phone Features window: 

 
 

1 

Perform one of the following steps: 

• Select Phone Features from the Tools menu in the Avaya IP Softphone Call Bar 
window. 

• Right-click on the Avaya IP Softphone icon, and select Phone Features. 

The Phone Features window appears. 

 

2 

Perform any of the following steps: 

• To activate a feature button, double-click on that feature. When a phone feature 
button is activated in Avaya IP Softphone, the icon next to the button is green. 

• To copy a feature to the Personal Phone Features window, right-click on the feature 
you want to copy, and select Add to Personal Features. 

• To modify the feature labels in the Phone Features window, right-click on the feature 
label you want to modify, select Rename, and then type the changes. To restore the 
feature label to its original label, right-click on the feature label, and select Restore. 

Important! 

If the feature you are renaming is also in your Personal Features window, the name 
will be changed there also. 

• To delete a feature button, right-click on the feature you want to delete, and select 
Delete. Whether you can delete a feature button depends on your user privileges. 
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Using the Personal Phone Features window 

To access the Personal Phone Features window: 

 
 

1 

Select Personal Phone Features from the Tools menu in the Avaya IP Softphone Call Bar 
window. 

The Personal Phone Features window appears. 

 

2 

Perform any of the following steps: 

• To activate a feature button, double-click on that feature. When a phone feature 
button is activated in Avaya IP Softphone, the icon next to the button is green. 

• To modify the feature labels in the Personal Phone Features window, right-click on the 
feature label you want to modify, select Rename, and then type the changes. To 
restore the feature label to its original label, right-click on the feature label, and select 
Restore. 

• To delete a feature button, right-click on the feature you want to delete, and select 
Delete. 
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